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Introduction

Topics in this chapter:

About this Guide on page 1

Notation Conventions on page 1
Related Documentation on page 2
Contacting Customer Support on page 2

About this Guide

This guide contains detailed information about installing and licensing Autodesk® Smoke® 2011 for Mac
0S® X. The document also contains general guidelines about preparing your workstation and operating
system before you install the Smoke software.

This document assumes that you have regular user knowledge of Apple® workstations and Mac OS X. You
do not need prior knowledge of Autodesk Visual Effects and Finishing software.

Notation Conventions

A number of style conventions are used throughout your documentation. These conventions and examples
of their use are shown as follows.

Convention Example

Text that you enter in a command line or shell appears install rpm -ga
in Courier bold. Press the Enter key after each com-
mand.

Variable names appear in Courier, enclosed in angle <filename>
brackets.




Convention Example

Feedback from the command line or shell appearsin  1imit coredumpsize
Courier.

Directory names, filenames, URLs, and command line  /usr/discreet
utilities appear in italics.

Related Documentation

Documentation for this release is installed with the product as PDF files and as an HTML help system, and
is also available on the Autodesk web site at http://www.autodesk.com/me-documentation. From this page you
can access the complete documentation library.

You should also refer to the product release notes for all late-breaking release information.

Contacting Customer Support
You can obtain support for Smoke on the Mac by making a Service Request at the Autodesk Subscription

Center (registration required).

Go to http://www.autodesk.com/subscriptionlogin. Once logged into your account at the Subscription Center,
select "Support Requests".

Customer support is also available through your Autodesk reseller. To find a reseller near you, consult
thereseller look-up database at http://www.autodesk.com/resellers.

Before calling Autodesk Customer Support, run the platforminfo command-line utility to gather important
information on your system.

To obtain system information:
1 Open the Terminal from the Applications / Utilities folder.

2 Type the following command:
platforminfo
The output looks similar to the following:
Workstation: MacPro4,1
CPU: 2 Quad-Core Intel Xeon @ 2.93 GHz, 8 cores
RAM: 12 GB of RAM
Graphics: NVIDIA Quadro FX 4800 Driver: 19.5.2f10
0OS: Mac O0S X 10.6.3 (10D561)

Kernel: Darwin 10.3.0

3 Send this information to Autodesk Customer Support.

2| Chapter 1 Introduction
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Preparing Your
Workstation

Topics in this chapter:

Preparing Your Hardware on page 3

Preparing Your Media Storage on page 3

Updating Your Operating System on page 4

Installing or Updating Hardware Drivers on page 4

Setting System Preferences on page 4

Configuring Your Network on page 5

Configuring Mac OS X Keyboard Shortcuts on page 5

Configuring Wacom Pen Buttons on page 6

Configuring Display Arrangement in Dual Monitor Configurations on page 7

Preparing Your Hardware

Before you set up your workstation, consult the Autodesk Smoke for Mac OS X System Requirements Web
page at www.autodesk.com/smoke-systemrequirements, and make sure your hardware meets the minimum
requirements for your version of Smoke for Mac OS X.

Consult your hardware documentation for information on how to install the necessary add-on cards in your
system (such as the NVIDIA® graphics card, and the AJA Kona card), and how to connect your workstation
to the peripherals you want to use it with (such as a pen tablet, graphics monitor, broadcast monitor, or
VTR).

Preparing Your Media Storage

Before configuring storage to work with Autodesk Smoke, contact your storage vendor to make sure your
storage fulfills the requirements for the frame format you will be working with.


www.autodesk.com/smoke-systemrequirements

Remember that, in order to ensure the best quality results, Autodesk Smoke does not apply compression to
rendered intermediates. This means that the storage bandwidth requirements are higher than those for
applications that use compressed media. Select the appropriate storage solution to achieve sustained real-time
playback.

Consult the Autodesk Smoke for Mac OS X System Requirements Web page at
www.autodesk.com/smoke-systemrequirements for guidelines about the throughput your storage should support
for various frame formats.

Consult your vendor documentation for information on connecting the media storage disks to your Mac,
and on using the Mac OS X Disk Utility to perform the RAID striping of your media storage device.

Recommended File System

For optimal performance, Autodesk recommends using the default Mac OS Extended Journaled (HFS+) file
system, for your system drive and your media storage volume.

Use the Mac OS X Disk Utility to format your media storage volume to the recommended file system. Consult
your Mac OS X documentation for information.

Updating Your Operating System

Consult the Autodesk Smoke for Mac OS X System Requirements Web page at
www.autodesk.com/smoke-systemrequirements for information on the version of the Mac OS X operating system
required for Autodesk Smoke.

To find out which version of Mac OS X your workstation is currently running, select About this Mac from
the Apple menu. The version number appears below the Mac OS X heading.

If your workstation is not running the required version of Mac OS X, click Software Update to upgrade your
operating system.

WARNING Do not update your operating system or hardware drivers to versions other than the ones recommended
by Autodesk. Ignore any updates offered by the Apple Software Update utility, unless instructed otherwise by
Autodesk.

Installing or Updating Hardware Drivers

Before installing Smoke, install or upgrade the drivers for your hardware devices.

Consult the Autodesk Smoke for Mac OS X System Requirements Web page at
www.autodesk.com/smoke-systemrequirements for information on the supported driver versions.

You can update some of the drivers, such as the NVIDIA graphics card driver, through the Apple Software
Update utility. To get drivers that are not installed by the Software Update utility (such as the AJA Kona
video card driver, or the Wacom® pen tablet driver), refer to the Web site of your hardware device vendor.

WARNING Do not install any driver versions other than the ones recommended by Autodesk. Ignore any driver
updates offered by the Apple Software Update utility, unless instructed otherwise by Autodesk.

Setting System Preferences

Open the System Preferences application, and set the following options as indicated in the table below.
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WARNING These settings are mandatory and will prevent Smoke from working correctly if they are not set as
documented.

NOTE These system preferences are set per Mac OS X user account. Make sure you apply them to all the Mac
OS X user accounts you plan to use with Smoke.

System Preference Option to Modify
Desktop & Screen Saver In the Screen Saver tab, set Start screen saver to Never.
Energy Saver B Set Computer sleep to never.

B Disable Put the hard disk(s) to sleep when possible.

Spotlight In the Privacy tab, add the Smoke media storage volume to the list of locations
Spotlight does not search.

Software Update In the Scheduled Check tab, disable Check for updates.

NOTE Before installing Mac OS X or QuickTime® updates, consult the Autodesk
Smoke for Mac OS X System Requirements Web page at www.autodesk.com/smoke-
systemrequirements, to see if these updates are compatible with the installed version
of Smoke.

Sound In the Output tab, make sure the device selected for sound output is not the AJA
card.
Select, for example, Internal Speakers, or Line Out.

Configuring Your Network

Smoke for Mac OS X supports both static IP and DHCP network configurations.

If your Mac uses DHCP to obtain its hostname or IP address, make sure the hostname and IP address assigned
to your computer do not change when the DHCP lease is renewed.

WARNING If the hostname or IP address of your Mac change while Smoke is running (for example, if your Mac
switches from a wired network to a wireless connection), close Smoke and restart your computer, to avoid any
issues with the application.

Configuring Mac OS X Keyboard Shortcuts

The Smoke application uses many keyboard shortcuts that are also used by Mac OS X.

As a general guideline, make sure your operating system does not use any single-key shortcuts (such as F1,
F2, etc.) or shortcuts that include the CTRL and OPTION key modifiers, as these could overlap with Smoke
hotkey combinations.

It is recommended to include the COMMAND key when defining OS-level shortcuts, as Smoke does not use
this key.

Update your keyboard preferences as suggested below. These changes are optional but will minimize keyboard
shortcut conflicts.

NOTE The keyboard preferences are set per Mac OS X user account. Make sure you apply them to all the Mac
OS X user accounts you plan to use with Smoke.

Configuring Your Network | 5
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To edit OS keyboard shortcuts:

1 Open the System Preferences application.
2 Click Keyboard.

3 In the Keyboard tab, enable Use all F1, F2, etc. keys as standard function keys.

NOTE This option is available only if you are using an Apple keyboard.

4 Click the Keyboard Shortcuts tab.

|0 Keyboard

a

| Keyboard | Keyboard Shortcuts ]

To change a shortcut, double-click the shortcut and hold down the new keys.

M Dashboard & Dock ™ Change the way Tab moves focus XF7
B Exposé & Spaces ™  Move focus to the menu bar ~E2
& Front Row ™  Move focus to the Dock “F3
Keyboard & Text Input ™ Move focus to active or next window ~F4
¥ Screen Shots [E Move focus to the window toolbar ~F§
i Services ™  Move focus to the floating window ~Fé
@ Spotlight [21 Move focus to next window in appl... #°
@ Universal Access ™ Move focus to the window drawer E
\, Application Shortcuts ™ Move focus to status menus ~F8
E Select the previous input source #Space
™ Select next source in Input menu 3 Space

T. (" Restore Defaults )

—— S

Full Keyboard Access: In windows and dialogs, press Tab to move keyboard focus between:

() Text boxes and lists only
) All controls

To change this setting, press CF7.

Replacing Batteries... ) { set Up Bluetooth Keyboard... ) @

5 Select each section in the left panel, and then disable all its keyboard shortcuts, or change the shortcuts
to include the COMMAND key.

Configuring Wacom Pen Buttons

To make sure the Wacom pen buttons work properly in Smoke, configure them as follows.

1 Open the System Preferences > Wacom Tablet panel.

6 | Chapter 2 Preparing Your Workstation



eannN Wacom Tablet

a
Tablet: =« n

&
Tool: | < E / i [fr==
AL C Crip Pen {5
[+]
Application: A =
[ Al ]
[ Pen | Eraser = Mapping |
Tilt Sensitivity
9 [ Double Click v
Normal High j
Tip Feel | Right Click T]
o o A
Soft Firm Tip Double Click Distance
TSI
[ Details... ) —
Py : : s :
Current Pressure: \ Off Large
i |
Click Full Click ( Default )
| S ———
About ) € Options...

2 If Grip Pen does not appear in the Tool section, touch the pen on the tablet.

3 Select the Pen tab.

4 Make sure the top pen button is assigned to the double-click function, and that the bottom pen button
is assigned to the right-click function.

Configuring Display Arrangement in Dual Monitor
Configurations

If your Mac uses two monitors, set the display arrangement to “Mirror Displays” in the Display Preferences
panel for best Wacom pen tablet usability in Smoke.

Using any other dual display mode will result in the pen tablet mapping to the incorrect screen or lacking
precision in Smoke.

Configuring Display Arrangement in Dual Monitor Configurations | 7






Installing and Licensing
Smoke

Topics in this chapter:

About Licensing on page 9

About Trial License Installation on page 10

About Installing Smoke with the Network License Server on page 12
About Standalone License Installation on page 19

Offline Registration and Activation on page 23

Uninstalling Smoke on page 24

Other Software on page 24

About Licensing

Your license determines how you install, register and activate your Smoke software.
W Trial license: gives you 30 days to evaluate the software. See About Trial License Installation on page 10.

B Network license: provided when you purchase commercial or educational editions of Smoke. See About
Installing Smoke with the Network License Server on page 12.
If you have the trial installed, you must re-install Smoke to install and configure the network license
server.

B Standalone license: provided for the student edition of Smoke. See About Standalone License Installation
on page 19.

With the network license, you get:

B Two seats of Autodesk Wiretap Gateway, which can be installed remotely

B One remote seat of Autodesk Burn



With the standalone license, you get:

B One seat of Wiretap Gateway that can only be installed locally

About Trial License Installation

A trial license of Smoke lasts for 30-days. The “Days Remaining” in your trial appears in the Product License
Activation window each time you start Smoke.

NOTE Do not use the Activate button from the Product License Activation window to activate a network license,
which you receive for commercial and educational editions of Smoke. You must re-install Smoke to activate your
network license. See About Installing Smoke with the Network License Server on page 12.

Installing the Trial Version Smoke

To install the trial version Smoke:

1 Locate the Smoke installer. Do one of the following:

B If you are installing Smoke from a DVD, insert the DVD, and then double-click the DVD icon that
appears on your desktop.

B If you are installing Smoke from a downloaded .dmyg disk image file, double-click the file.
The contents of the DVD or .dmg disk image are displayed.

2 Double-click Install Smoke 2011.
The installer starts.

3 Click Continue.

The Important Licensing Information window appears.

4 Click Continue.

(L NaNé) < Install Autodesk Smoke 2011 SP4 For Mac OS X

Important Licensing Information

« Smoke Trial Users: DO NOT USE the ACTIVATE button on the
& Introduction License Activation screen to register your product {unless you
© Licensing have the student edition of Smoke).
i Calart N . - I
B Destination Select | « You must reinstall Smoke to switch from a Trial license to a
| fully-registered Network license.

s It is recommended to select “Single License Server” and "Use
@ Installatior | local machine” if you only have one Autodesk product in your
facility.

| « Carefully read the Installation and Licensing Guide for

| detailed instructions:
http://download.autodesk.com/us/systemdocs/pdf/ |
smoke201lmacosx_install_licensing_guide.pdf

GoBack ) ( Continue

The Product Information window appears.
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5 Select “I want to try this product for 30 days”.
806

Product Information

i introduction ® 1 want to try this product for 30 days

@ Licensing
© Destination Select () I have my product information

© Media Storage Serial number

@ Installation Type

® Installation Product key
@ Summary 776C1

Your serial number and product key are located on the
product package or in your Autodesk Upgrade and
Licensing Information email.

You may enter your product information at any time
following installation.

( Go Back ) ( Continue )
A

6 Depending on your OS configuration, the Select a Destination window may appear.

~

M w Install Autodesk Smoke 2011 5P4 For Mac OS X

Select a Destination

. How do you want to install this software?
& Introduction

© Licensing |;| Install for all users of this computer
& Destination Select

® Media Storage
@ Installation Type
® Installation

® Summary

Installing this software requires 1.16 GB of space.

You have chosen to install this software for all users of this
computer.

C Go Back :] ( Continue )

4

Click “Install for all users of this computer”, and then click Continue.

7 The Media Storage window appears. This windows enables you to define an internal or external storage
volume for your media. Click Select.

Installing the Trial Version Smoke | 11
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11

12

sNeO « Install Autodesk Smoke 2011 SP4 For Mac OS X

Media Storage

@ Introduction Media Storage Folder : [Volumes/G-SPEED/AutodeskMedia

@ Licensing ( select... )

© Destination Select

The Media Storage folder stores all imported and rendered frames, as

well as audio files, used in your projects. For optimal performance,

| select a fast storage device. Avoid selecting the system drive as this will
impair performance. Note: To prevent Mac 05 X Spotlight from
impacting storage performance, open System Preferences > Spotlight
Preferences, click Privacy and add the media storage folder to the
list.

© Media Storage

‘ Media Storage Name :  AdskMedia |

The Media Storage name is a user-friendly name used by the
application to refer to your Media Storage folder. This name is also

| used to identify the Media Storage on a Wire network. Try using a
descriptive or unique name.

GoBack ) ( Continue )

N

A file browser window opens.

Browse to the volume you want to use for media storage. The installer will automatically create a
subfolder called ManagedFolder7 under the folder you select, so that all Smoke media files are kept in
one place.

WARNING Never use your Mac OS X system disk for media storage, as this may fill up the drive and impair
system performance.

Type a name for your media storage folder in the Media Storage Name field. This name will also be used
by Smoke to refer to your media storage folder.

NOTE This name can only contain non-accented latin letters and numbers. Do not use special characters.

Click Continue.

Click Install to begin the installation process.

Smoke is installed.

Start Smoke. In the Product License Activation window, click Try.

Converting from Trial to a Network License

When you purchase the commercial or educational edition of Smoke, you receive a network serial number
and license.

You must re-install Smoke to install and configure the network license server. Do not click the Activate
button to activate a commercial or educational edition of Smoke.

See About Installing Smoke with the Network License Server on page 12.

About Installing Smoke with the Network License Server

A network license is required for commercial and educational editions of Smoke.

12 | Chapter 3 Installing and Licensing Smoke



NOTE If you have a trial version of Smoke installed, you must re-install Smoke to install and configure the license
server. Do not use the Activate button from the Product License Activation window to activate a network license
of Smoke.

With a network license, you must install a license server to manage the license.

m If you have only one Autodesk product running on a single workstation, the license server can be installed
and set up for you automatically on the same workstation as Smoke. See Installing Smoke with a Local
Network License Server on page 13.

B If you must manage multiple Autodesk licenses across your network, you must install and configure the
license server on a dedicated workstation before you install Smoke. See Network Licensing on page 47.

Do not use the Activate button, unless you have a Student edition

If you have a Trial version of Smoke installed and you want to license it, do not use the Activate button in
the Product License Activation window to activate your license. You must re-install Smoke. See Installing
Smoke with a Local Network License Server on page 13.

Installing Smoke with a Local Network License Server

If you have a trial installed, you must reinstall Smoke to install and configure the license server.

Follow this procedure to install the license server on the same machine as Smoke.

NOTE If you have a version of Smoke older than Service Pack 4 installed on your workstation, you must uninstall
it before you install, register, and activate Service Pack 4.

To install Smoke with a local network license server:

1 Locate your serial number. The serial number is located on the outside of the product packaging, or in
the Autodesk® Upgrade and Licensing Information email.

NOTE If you have lost your serial number, contact the Autodesk Business Center (ABC) at 800-538-6401 for
assistance.

2 Locate the Smoke installer. Do one of the following:

B If you are installing Smoke from a DVD, insert the DVD, and then double-click the DVD icon that
appears on your desktop.

B If you are installing Smoke from a downloaded .dmg disk image file, double-click the file.
The contents of the DVD or .dmg disk image are displayed.

3  Double-click Install Smoke 2011.
The installer starts.

4 C(Click Continue.

The Important Licensing Information window appears.

5 Click Continue.

Do not use the Activate button, unless you have a Student edition | 13



O

« Install Autodesk Smoke 2011 SP4 For Mac 0S X

O Introduction

B Licensing

® Destination Select
® Media Storage

® Installation Type
® Installation

® Summary

Important Licensing Information

« Smoke Trial Users: DO NOT USE the ACTIVATE button on the
License Activation screen to register your product {unless you
have the student edition of Smoke).

= You must reinstall Smoke to switch from a Trial license to a
fully-registered Network license.

» It is recommended to select “Single License Server” and "Use
local machine” if you only have one Autodesk product in your
facility.

» Carefully read the Installation and Licensing Guide for
detailed instructions:
http://download.autodesk.com/fus/systemdocs/ pdf/
smoke2011lmacosx_install_licensing_guide. pdf

( Go Back ) ( Continue )

The Product Information window appears.

6 Select “I have my product information” and enter your serial number.

8N6

« Install Autodesk Smoke 2011 5P4 For Mac OS X

& Introduction

© Licensing

© Destination Select

& Media Storage
@ Installation Type
® Installation

® Summary

The License Type window appears.

7 Select Network License.

14 | Chapter 3 Installing and Licensing Smoke

Product Information

() 1 want to try this product for 30 days

@ | have my product information

Serial number

Product key
776C1

Your serial number and product key are located on the
product package or in your Autodesk Upgrade and
Licensing Information email.

Continue

| GoBack |
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AaNo « Install Autodesk Smoke 2011 5P4 For Mac 0S X

License Type

© Introduction ) Network license

@ Licensing
© Destination Select () stand-alone license (Student Edition Only)

© Media Storage
A Network license allows you to run Autodesk Smoke

® Instaliation Type with a license that is shared by various computers on a
@ Installation network.
8 summary Select this option if you have purchased Autodesk Smoke

and are ready to configure your installation.

For detailed instruction on how to setup your Network
License please consult the Autodesk Smoke 2011
Installation and Licensing Guide.

[ GoBack ) ( Continue )
A

“
Network License Configuration window opens.

faNe  Install Autodesk Smoke 2011 SP4 For Mac OS X

Network License Configuration

: Don't have your license file? Click here to register your
© Introduction R ; : :

product before continuing with your installation.

@ Licensing
The information entered below must be the same values
used during the registration process.

& Media Storage (

© Destination Select

Single license server |5 ] E Use local machine

® Installation Type
Server hostname:
@ Installation

& Stirimary Server ID: 002500eele&b

The Network License Manager is installed on a single
server so license management and activity is restricted to
this server. You can either select your local Smoke
workstation or a remote server on your network.

Please read the Autodesk Smoke Installation and
Licensing Guide for detailed instructions for all Network
license server models.

[ GoBack | ( Continue

Vi

If you do not have your license file, you must register your product to receive your license file and
continue the installation process.

Click the “Click here” link.

A browser window opens. You must create an Autodesk User ID, if you do not have one, and fill in all
of the required information, including your serial number, Server host name and Server ID.

If you do not know the Server host name or Server ID of your machine:

B Look in the installer. This information appears in the Network License Configuration window if
you have Use Local Machine selected.

B If you have advanced to another screen, you can get this information in the About This Mac window.
See Get Your License Server Hostname and Server ID Manually on page 19.

NOTE Remove the colons “:” from the Mac address when you register your product on the Autodesk website.

Installing Smoke with a Local Network License Server | 15



8ane Autodesk - RegisterOnce )

oD

] [ =" |ﬂ https:/ /registeronce.autodesk.com/custreg/beginRegistration.actio c.] [ Q~ Google ]

Your Multilingual Mac  AppleScript Sudo  Giving Your ...Center Blog rappel - javascript= Autodesk Wiki »

Autodesk

LogIn
Are you a New User? Click "Create User |D Now™.
Please enter your User ID, Password and click "Log In” to access the Autodesk service you Log-in to Autodesk
requested. You can use your existing Subscription Center or Partner Center User |D and
Password. Don't have an Autodesk User ID?
Registered Autodesk users are able to access various Autodesk services including: Signing up is quick and sasy!
« Product Registration and Activation A =
« Subscription Center T
« Partner Center
« Web Support User ID
Users from Japan with an existing Contact |D, please click here.
Password
The information you provide will be used by Autedesk to register andfor issue your activation
code, to keep you informed about our products and services, and to ensure that you benefit =
from being an authorized Autodesk user. Autodesk does not sell or otherwise provide your [_] Remember Me
information to anyone cutside of Autodesk or our Authorized Business Partners. If you wish to
correct your registration data, please click the link below to contact Autodesk or contact your
local Autodesk office.
Log In I
ts reserved cy Po
-
i
v
€ . IR

You license appears in your browser window. Keep the window open while you continue the installation
process. You can save this file anywhere on your machine with any name.

Continue with the installation.

9 In the Network License Configuration window, select the following:
W Single license server

B Use local machine

Aanm « Install Autodesk Smoke 2011 5P4 For Mac OS5 X

Network License Configuration

; Don't have your license file? Click here to register your
© Introduction s ; : .
product before continuing with your installation.
@ Licensing
The information entered below must be the same values

© Destination Select used during the registration process.

© Media Storage Single license server |+ ] ¥ Use local machine

Server hostname:

Server ID: 002500eele8b

The Network License Manager is installed on a single
server so license management and activity is restricted to
this server. You can either select your local Smoke
waorkstation or a remote server on your network.

Please read the Autodesk Smoke Installation and
Licensing Guide for detailed instructions for all Network
license server models.

GoBack ) ( Continue )

NOTE Make sure Use local machine is selected.

16 | Chapter 3 Installing and Licensing Smoke



10 Copy and paste your license information into the window. Be sure not to overwrite any previous license
entries.

License File

& Introduction Please copy & paste your Network License key below.

8 Licensing

© Destination Select
& Media Storage

® Installation Type

® Installation

® Summary

C Go Back ) CContinue )

A
11 Depending on your OS configuration, the Select a Destination window may appear.
HaXels) @ Install Autodesk Smoke 2011 SP4 For Mac 0S X |
Select a Destination
! How do you want to install this software?
& Introduction
© Licensing |;| Install for all users of this computer
& Destination Select
® Media Storage
@ Installation Type
® Installation
® Summary
Installing this software requires 1.16 GB of space.
You have chosen to install this software for all users of this
computer.
C Go Back ) ( Continue )
4

Click “Install for all users of this computer”, and then click Continue.

12 The Media Storage window appears. This windows enables you to define an internal or external storage
volume for your media. Click Select.

Installing Smoke with a Local Network License Server | 17



fANO  Install Autodesk Smoke 2011 SP4 For Mac OS X

Media Storage

@ Introduction Media Storage Folder : [Volumes/G-SPEED/AutodeskMedia
@ Licensing [ Select... )

© Destination Select
The Media Storage folder stores all imported and rendered frames, as

© Media Storage well as audio files, used in your projects. For optimal performance,
select a fast storage device. Avoid selecting the system drive as this will

® Installation Type impair performance. Note: To prevent Mac 05 X Spotlight from
impacting storage performance, open System Preferences > Spotlight

@ Installation Preferences, click Privacy and add the media storage folder to the

® Summary list

Media Storage Name : | AdskMedia

The Media Storage name is a user-friendly name used by the
application to refer to your Media Storage folder. This name is also
used to identify the Media Storage on a Wire network. Try using a
descriptive or unique name.

( Go Back | [ Continue

A file browser window opens.

13 Browse to the volume you want to use for media storage. The installer will automatically create a
subfolder called ManagedFolder7 under the folder you select, so that all Smoke media files are kept in
one place.

WARNING Never use your Mac OS X system disk for media storage, as this may fill up the drive and impair
system performance.

14 Type a name for your media storage folder in the Media Storage Name field. This name will also be used
by Smoke to refer to your media storage folder.

NOTE This name can only contain non-accented latin letters and numbers. Do not use special characters.

15 Click Continue.
16 Click Install to begin the installation process.

ANMm « Install Autodesk Smoke 2011 SP4 For Mac OS X

Standard Install on “MacHD”

© Introduction
© Licensing This will take 1.17 GB of space on your computer.

© Destination Select Click Install to perform a standard installation of
this software for all users of this computer. All
users of this computer will be able to use this

@ Installation Type software.

@ Media Storage

® Installation

® Summary

(" Go Back |( Install )

18 | Chapter 3 Installing and Licensing Smoke



Smoke is installed and ready to run.

If Smoke does not start, see Troubleshooting License Errors on page 36.

Get Your License Server Hostname and Server ID Manually

You must provide your license server hostname and server ID during the installation process.

In most cases, you will install the license server on the same machine as Smoke. You may consider installing
the license server on another machine if you have multiple Autodesk products to manage.

To get your license server hostname and server ID:

1 Open About this Mac.

a b
+ a6 Mac Pro
1
alesia 7/30/10 11:54 AM
| Contents Idle Reminder Time: 1800
| Craphics/Displays IPCP Compression V]: Yes
Hardware RAID LCP Echo Enabled: No
M LCP Echo Failure: 4
oy LCP Echo Interval: 10
PCI Cards Log File: fvar/log/ppp.log
Parallel 5CSI Verbose Logging: No
Power Ethernet 1:
2 o~ Type: Ethernet
Friners | BSD Device Mame: enl
SAS — Hardware (MAC) Address: 00:25:00:ee:1e:8b
Serial-ATA | 1Pvd:
USB | Addresses: 172.16.129.229
¥ Network | Configuration Method: Manual
EA_D; | Router: 172.16.128.1
ik Subnet Masks: 255.255.248.0
Firewall | IPvE:
| Configuration Method: Automatic
Modems | DNS: . .
Volurias | Search Domains:  rd.discreet.qc.ca, autodesk.com
| Server Addresses: 172.16.136.30, 172.16.136.31
WIWAN Proxies:
¥ Software | Exceptions List: *.local, 169.254/16
Applications | FTP Passive Mode: Yes
| Ethernet 2:
Devela.per - Type: Ethernet
Extensions BSD Device Name: enl
Fonts Hardware (MAC) Address: 00:25:00:ed:fa:31
Frameworks 1Pvd: ~ ) A
L i Configuration Method: DHCP v
00s £ IPVE:

Mananad Clisnt -

a. License Server Hostname b. License Server ID

2 Click More Info.

3 The Server hostname appears on the top left corner of the window and the Server ID is the Hardware
MAC address.

NOTE Remove the colons “:” from the Mac address when you register your product on the Autodesk website.

About Standalone License Installation

A standalone license is only available for the student edition of Smoke. Student licenses do not require a
license file or a license server.

When you register the student edition, you receive a serial number which is required during the installation
and activation process. See Student License: Installing and Activating Smoke.

About Standalone License Installation | 19



Installing and Activating the Student Edition of Smoke

B If you have a Trial installed, start Smoke, click Activate and follow the instructions on the website. You

must have your serial number.

m If Smoke is not installed, use the following instructions.

NOTE If you have a version of Smoke older than Service Pack 4 installed on your workstation, you must uninstall
it before you install, register, and activate Service Pack 4.

To install Smoke (student edition):

1

6

Locate your serial number. The serial number is located on the outside of the product packaging, or in
the Autodesk® Upgrade and Licensing Information email.

NOTE If you have lost your serial number, contact the Autodesk Business Center (ABC) at 800-538-6401 for
assistance.

Locate the Smoke installer. Do one of the following:

B If you are installing Smoke from a DVD, insert the DVD, and then double-click the DVD icon that
appears on your desktop.

B If you are installing Smoke from a downloaded .dmyg disk image file, double-click the file.
The contents of the DVD or .dmg disk image are displayed.

Double-click Install Smoke 2011.
The installer starts.

Click Continue.

The Important Licensing Information window appears.

Click Continue.

(o Na M) < Install Autodesk Smoke 2011 SP4 For Mac OS X

Important Licensing Information

« Smoke Trial Users: DO NOT USE the ACTIVATE button on the
6 Introduction License Activation screen to register your product {unless you
© Licensing have the student edition of Smoke).
B Destination Select | = You must reinstall Smoke to switch from a Trial license to a
® Media Storage fully-registered Network license.
Type » It is recommended to select “Single License Server” and "Use
| local machine” if you only have one Autodesk product in your
| facility.

« Carefully read the Installation and Licensing Guide for
detailed instructions:
http://download.autodesk.com/us/systemdocs/ pdf/ |
smoke201lmacosx_install_licensing_guide.pdf

N

Go Back Continue

The Product Information window appears.

Select “I have my product information” and enter your serial number.
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anNe

Product Information

Riintroduction () 1 want to try this product for 30 days

@ Licensing
© Destination Select @ | have my product information

© Media Storage Serial number

® Installation Type

® Installation Product key

® Summary 776C1

Your serial number and product key are located on the
product package or in your Autodesk Upgrade and
Licensing Information email.

C Go Back ) Continue

4

The License Type window appears.
7 Select “Standalone license (Student Edition Only)”.
AN

License Type

B Introduction O Network license

& Licensing
® Destination Select %) Standalone license (Student Edition Only)

® Media Storage
N A standalone license allows you to run Autodesk Smoke
@ Installation Type on a single workstation.
@ Installation y - , . ;.
Only select this option if you are installing Smoke with a
@ Summary Student activation key.

(_ Go Back :] ( Continue )
4

8 Depending on your OS configuration, the Select a Destination window may appear.

Installing and Activating the Student Edition of Smoke | 21



A.AA @ Install Autodesk Smoke 2011 SP4 For Mac 05 X

& Introduction

& Licensing

& Destination Select
® Media Storage

@ Installation Type

@ Installation

® Summary

Select a Destination

How do you want to install this software?

|;| Install for all users of this computer

Installing this software requires 1.16 GB of space.

You have chosen to install this software for all users of this
computer.

C Go Back ) [Continue )

Click “Install for all users of this computer”, and then click Continue.

The Media Storage window appears. This windows enables you to define an internal or external storage

volume for your media.

9 Click Select.

22 | Chapter 3
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& Introduction

@ Licensing

© Destination Select
& Media Storage

® Installation Type

® Installation

® Summary

A file browser window opens.

Installing and Licensing Smoke

Media Storage

Media Storage Folder : /Volumes/G-SPEED/AutodeskMedia

The Media Storage folder stores all imported and rendered frames, as
well as audio files, used in your projects. For optimal performance,
select a fast storage device. Avoid selecting the system drive as this will
impair performance. Note: To prevent Mac 05 X Spotlight from
impacting storage performance, open System Preferences > Spotlight
Preferences, click Privacy and add the media storage folder to the

list.

Media Storage Name : [MskMedia I

The Media Storage name is a user-friendly name used by the
application to refer to your Media Storage folder. This name is also
used to identify the Media Storage on a Wire network. Try using a
descriptive or unique name.

( Go Back j ( Continue )

4



10

11

12
13

14
15
16

Browse to the volume you want to use for media storage. The installer will automatically create a
subfolder called ManagedFolder7 under the folder you select, so that all Smoke media files are kept in
one place.

WARNING Never use your Mac OS X system disk for media storage, as this may fill up the drive and impair
system performance.

Type a name for your media storage folder in the Media Storage Name field. This name will also be used
by Smoke to refer to your media storage folder.

NOTE This name can only contain non-accented latin letters and numbers. Do not use special characters.

Click Continue.

Click Install to begin the installation process.

Smoke is installed.
Start Smoke.
In the Product License Activation window, click Activate.

Enter your serial number and follow the steps to register and activate your product online. If you do
not have an internet connection, see Offline Registration and Activation on page 23.

Offline Registration and Activation

If for some reason online registration and activation is not possible, you can still register and activate your
product offline. Contact Autodesk by mail, fax, or phone. Your activation code is sent back to you by mail
or fax.

E-mail Create an e-mail message with your registration information and send it to Autodesk.

Fax Enter your registration information, and fax the information to Autodesk.

Phone Provide your registration information to one of our representatives over the phone.

Use the numbers or e-mail address that correspond to your area:

Area e-mail Fax and Phone Numbers
United States, authcodes@autodesk.com FAX:
Canada 800.225.6490 or
Latin America 415.507.4937
Phone:
800.551.1490
Europe authcodes.neu@autodesk.com Fax:
Middle East +41 (32) 7239169
Africa
Asia Pacific ap.register@autodesk.com Fax: +65.6735.4857

Offline registration and activation is necessary under the following conditions:

B An online request has timed out

B A processing error occurred such as an invalid serial number

Offline Registration and Activation | 23



Uninstalling Smoke

Perform the following procedure to uninstall Autodesk Smoke from your Mac.

NOTE The License Server is not uninstalled when you uninstall Smoke. See Content reference to: Uninstall the
Network License Manager.

To uninstall Smoke from your Mac:

1

2
3
4

If Smoke is running, exit it.
In Finder, go to the Applications / Autodesk / Smoke 2011 folder.
Run the Smoke 2011 Uninstaller application, and follow the on-screen instructions to uninstall Smoke.

(Optional, for advanced users) Perform the following steps to completely remove all the files installed
by Smoke on your system drive:

B Open Finder, and click COMMAND+SHIFT+G.

B In the dialog box that opens, enter /usr/discreet.
The contents of the /usr/discreet folder are displayed.

‘ano [ ] archive =
Q
DEVICES [ Applications {3 bin
‘m [ Developer | discrest [3 ] backburner L
(& Library [ include [ CleanerPraofile
e & opt ll lib e clip
PG R |58 System [ libexec [ font
@ Al @ Users [ local s o
PLACES us » |l shin [ lib32
P Deskiop [ share |j lib64
M Applications .__1 standalone I log
;; T %11 L |j Lustre_Color
Dsharad lxlll X11R6 g mio
[ project
SEARCH FOR (] smoke_2010.2
|l sparks
& src
[ sw
[ SystemCentral
[ user
|: wiretap

] wiretapcentral
[ wiretapgateway

el xml

) MacHD « [ usr » [ discreet » [ archive

0 items, 626.5 GB available e

B Delete all the subfolders under the discreet folder, with the exception of the clip, project and user
folders. These folders contain the data files of the projects and clips you created in Smoke, and might
be useful next time you install Smoke.

Other Software

The following components are installed by default with Smoke:

24 | Chapter 3

Autodesk Backburner Manager
Autodesk Backburner Server
Autodesk WiretapCentral

Autodesk Wiretap Gateway
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B Autodesk Backburner Media I / O Adapter

B License Server

Installing and Licensing Wiretap Gateway

Wiretap Gateway reads image media in any format from any storage device, and streams it live as raw RGB
to local or remote clients. When you import files using a Gateway Library from the Clip Library in Smoke,
it is Wiretap Gateway that gives you access to those files.

By default, Wiretap Gateway is installed with Smoke and there is nothing more you have to do to make it
work for your local installation of Smoke.

If you have a network license of Smoke, you can install up to two remote Wiretap Gateway servers to provide
transcoding services to a number of other workstations throughout your network.

You must license remote Wiretap Gateway servers.

For instructions on installing and licensing Wiretap Gateway on remote workstations, see the Autodesk Wiretap
Central and Autodesk Wiretap Gateway Installation Guide.

Installing and Licensing Autodesk Burn

Autodesk Burn is a Linux-based network processing solution. Burn allows you to render images in the
background using low-cost systems and frees your workstation for more creative tasks.

Your distribution of Smoke comes with a distribution of Burn, which you can deploy on a Linux workstation
on your network.

For information on installing and licensing Burn, see the Autodesk Burn Installation and User Guide.

Installing and Licensing Wiretap Gateway | 25
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Configuring Smoke

Topics in this chapter:

About Configuring Smoke on page 27

Configuring General Settings on page 27

Defining the Video Preview Device on page 29
Defining VTRs on page 30

Configuring VIR Emulation on page 30

Adding or Editing Media Storage Volumes on page 31
Configuring Backburner Settings on page 32
Configuring the License Server on page 34

About Configuring Smoke

The Smoke Setup utility allows you to easily configure general Smoke settings, add or edit the media storage,
configure background rendering, and configure licensing.

Run the Smoke Setup utility from the Applications / Autodesk / Smoke 2011 / Utilities folder.

Configuring General Settings

The General tab of the Smoke Setup utility enables you to configure the following application settings.
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ANO Smoke Setup

Select the application to configure | smoke_2011.5P4.betal |3 ]

[ General Preview Vtr Emulator Media Storage Backburner Licensing !
Video Device W]
Audio Device @
Reserved Application Memory Automatic [?
Max Library Size 75 MB 8
Network Panel Display ShowMounted e
Default Web Browser open

Cleaner Export Destination Path C:\Tmp

Archiving
Archive Size 1024 mB ITI
Default Location Jvarj/tmp/archive

Table of Contents Location Jusr/discreet/archive

T ———
( Manual Edit

( Reload ) Apply )

“

Video Device Use this setting to specify the video output device to be used with Smoke. If your Mac
is equipped with an AJA Kona 3 card, select KONA 3.

Audio Device Use this setting to specify the audio output device to be used with Smoke. If your Mac
is equipped with an AJA Kona 3 card, select AJA. Otherwise, select CoreAudio to use the default sound
card of your workstation.

NOTE You can only use the AJA card as an audio device if you also set the AJA card as the video device. Similarly,
you can only use CoreAudio if the AJA card is not set as the video device.

Reserved Application Memory  Use this field to specify the amount of memory allocated for Smoke
frame buffers. In most cases, you should leave this setting to Automatic. The default configuration is
sufficient for most projects, regardless of the different resolutions you may be working with.

Max Library Size  Use this setting to define the maximum size of any single clip library, in megabytes.
The higher the value, the more memory the application uses. Using a larger value reduces memory
fragmentation, which optimizes memory use.

NOTE To run Smoke, you must have at least 10 megabytes of free hard drive space in addition to the value
set by this field.

Network Panel Display  Use this setting to filter the list of remote media storage volumes that are
displayed in the Network panel. Select ShowMounted to see only media storage volumes that are mounted
and available on the Wire network, or ShowAll to show all media storage volumes available on the network
without checking whether they are mounted.

NOTE Using ShowAll slightly reduces the time needed for your application to start, as no checks are performed
on remote media storage volumes.

Default Web Browser  Use this setting to specify the Web browser used by Smoke to browse the Help
and view HTML tables of contents for archives. Set this option to open to use the default Web browser.

Configuring Smoke



B Cleaner Export Destination Path  If you are using Autodesk® Cleaner® XL digital video mastering and
encoding software, use this field to define the default path on a Microsoft® Windows® workstation where
clips are saved after encoding by Cleaner XL. The default path you enter appears in the Cleaner Destination
Path field when you select Cleaner in the Format Box of the Image Export menu. You can edit the path
there. If there is an ftp path in the output profile, the ftp path is used as an additional destination for
encoded jobs. See your application help.

B Archive Size Use this field to define the maximum size for a file archive in MB. The default value is
1024MB.

B Default Location Use this field to define the default location for archives created in Smoke. The default
location is /var/tmp/archive.

B Table of Contents Location  Use this field to define the location where online HTML and ASCII tables
of contents are saved when archiving. The default location is /usr/discreet/archive.

NOTE If you prefer to edit these parameters directly in the application configuration file, click Manual Edit. Be
very careful when working with the configuration file. Incorrect settings may make your application unusable.

When you have finished configuring these settings, click Apply to save them. If you want to revert to the
last saved configuration, click Reload. Note that this will undo unsaved changes in all the tabs of the Smoke
Setup utility.

Defining the Video Preview Device

Use the Preview tab of the Smoke Setup utility to specify the device used for the graphics-to-video display.

Enable entries for the resolutions of the projects on which you will be working, as well as the resolutions
supported by your hardware configuration.

If necessary, you can also add new entries, and duplicate or delete existing entries.

a.nNn Smoke Setup

Select the application to configure | smoke_2011.5P4.betal | & ]

| General Preview | Vtr  Emulator =~ Media Storage Backburner | Licensing |

Active Description Device = Channel | XSize @ YSize Refresh SyncSource XOffset
2 O = ntsc aja 1 720 | 486 |30 601sync
2 ([ pal aja 1 720 (576 |25 601sync
38 . 1280x720@5000p aja 1 1280 720 |5000p . DTVsync
4 10 1280x720@5994p aja 1 1280 | 720 | 5994p DTVsync
s = . 1280x720@6000p aja . 1 . 1280 | 720 | 6000p . DTVsync
6 [ . 1920x1080@23976psf aja . i . 1920 1080 23976p5f. DTVsync
7 | B8 1920x1080@24000psf aja 1 1920 | 1080 | 24000psf | DTVsync
2 I . 1920x1080@23976p aja . 1 . 1920 | 1080 | 23976p . DTVsync
s |0 1920x1080@24000p aja bt 1920 | 1080 | 24000p | DTVsync
10| 0 . 1920x1080@25000psf aja . I . 1920 | 1080 50i . DTVsync
11 = 1920x1080@2997p aja 1 1920 | 1080 | 2997p DTVsync =
(—____- _______________ i e e -____’ 1 4;?

. E—T— ;
Reload Apply )

S
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When you have finished configuring these settings, click Apply to save them. If you want to revert to the
last saved configuration, click Reload. Note that this will undo unsaved changes in all the tabs of the Smoke
Setup utility.

Defining VTRs

Use the Vtr tab of the Smoke Setup utility to specify the video tape recorders you want to use for clip I/0O.

You can enable VTRs of different video formats. Any enabled VTR can be selected for a project, regardless
of the project's video I/O timings.

If necessary, you can also add new entries, and duplicate or delete existing entries.

ann - Smoke Setup

Select the application to configure | smoke_2011.5P4.betal | % ]

f' General Preview |=W¥tr Emulator = Media Storage Backburner  Licensing '

Active | Protocol Name Input Format Timing ColorSpace
1 = sony D1 NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOI‘B
2= . sony . D1 PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOM
3 |B8 sony Betacam NTSC SERIAL1 NTSC YCBCR_RGB_CONVERSION
4 (3 . sony . Betacam PAL . SERIALL . PAL YCBCR_RGB_CONVERSIOPM
5 | = sony DigiBeta NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOM
6§ | . sony . DigiBeta PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOPM
7 | B BTS D1 BTS NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOM
g (OO . BTS . D1 BTS PAL . SERIALL . PAL YCBCR_RGB_CONVERSIOM
3 [ sony DVCPRO NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOM
10|80 . sony . DVCPRO PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOM
1|8 BWWS0 | BvwS50 NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOM &

— 1 1 1 1 - £

I S er———
([ New | [ Duplicate ] [ Delete )

(" Reload ) [ Apply )

4

When you have finished configuring these settings, click Apply to save them. If you want to revert to the
last saved configuration, click Reload. Note that this will undo unsaved changes in all the tabs of the Smoke
Setup utility.

Configuring VTR Emulation

Use the Emulator tab of the Smoke Setup utility if you want to configure your workstation to emulate a
Sony™ VTR.

You can specify more than one emulator. Any enabled emulator can be selected for a project, regardless of
the project's video I/O timings.

If necessary, you can also add new entries, and duplicate or delete existing entries.
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ann - Smoke Setup

Select the application to configure | smoke_2011.5P4.betal | & ]

I General Preview |~Wtr Emulator = Media Storage Backburner  Licensing '
Active | Protocol Name Input Format Timing ColorSpace
= sony D1 NTSC SERIAL1 NTSC YCBCR_RGB_CONVERSIOI‘@
2= . sony . D1 PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOM
3 |8 sony Betacam NTSC SERIAL1 NTSC YCBCR_RGB_CONVERSION
4 |03 . sony . Betacam PAL . SERIALL . PAL YCBCR_RGB_CONVERSIOM
s |10 sony DigiBeta NTSC SERIAL1 NTSC YCBCR_RGB_CONVERSION
s (& . sony . DigiBeta PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOM
o = BTS D1 BTS NTSC SERIALL NTSC YCBCR_RGB_CONVERSION
s | O . BTS . D1 BTS PAL . SERIALL . PAL YCBCR_RGB_CONVERSIOM
5 (O sony DVCPRO NTSC SERIAL1 NTSC YCBCR_RGB_CONWVERSION
10| . sony . DVCPRO PAL . SERIALL . PAL . YCBCR_RGB_CONVERSIOM
1|8 BWWS0 | BvwS50 NTSC SERIALL NTSC YCBCR_RGB_CONVERSIOM &

IR AT AT
[ New { Duplicate | Delete )

" S | A
[ Reload ) [ Apply

4

When you have finished configuring these settings, click Apply to save them. If you want to revert to the
last saved configuration, click Reload. Note that this will undo unsaved changes in all the tabs of the Smoke
Setup utility.

Adding or Editing Media Storage Volumes

Use the Media Storage tab of the Smoke Setup utility to define new media storage volumes for use with
Smoke, or to edit the settings of existing media storage volumes.

ano Smoke Setup

Select the application to configure | smoke_2011.5P4.betal | % ]

! General Preview  Vtr  Emulator | Media Storage | Backburner | Licensing |

Id Name Location 8-bit Integer 10-bit Integer

1|7 AdskMedia | /Volumes/G-5PEED/AutodeskMedia/ManagedFolder? | Default Default |

€cee— ———————————————————— =) Al

- — T
[ Manual Edit | [ Add )

bl

( Reload ) ( Appl
(_Reload ) [ Apply )

=
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To define a new media storage volume, click Add.

A new entry is created in the media storage list, and is populated with default values.

NOTE For safety reasons, the Name and Location fields are blank by default. You are required to fill in these fields
before you can click Apply.

To edit the settings of a media storage folder:

1 Double-click the Name field and enter a meaningful label for the media storage. For example, MyMedia.

This label identifies the media storage in Smoke.

2 Double-click the Location field, and browse to the directory that will contain the Smoke media files on
your storage device. For example, / Volumes/G-SPEED/ManagedFolder7.

WARNING Do not select the root of a drive as your media storage folder. Create a subfolder to hold all your
media files in one place. We recommend that you name the subfolder ManagedFolder<x>, where <x> is the
number that appears in the Id column in the Smoke Setup utility.

3 (Optional) Double-click the 8-bit Integer, 10-bit Integer, 12-bit Integer and 12-bit Packed Integer fields,
and choose the file formats that Smoke will use when writing frames of those bit depths to the storage.

4 (Optional) If you plan to use the JPG file format, double-click the Jpeg Compression field, and set JPEG
compression to a value between 0 (lowest compression, highest quality) and 100 (highest compression,
lowest quality).

5 Click Apply to save your configuration.

If you want to revert to the last saved configuration, click Reload. Note that this will also undo any
unsaved changes in the other tabs of the Smoke Setup application.

NOTE If you prefer to edit these parameters directly in the storage configuration file, click Manual Edit. Be very
careful when working with the configuration file. Incorrect settings may make your application unusable.

Configuring Backburner Settings

If you want to use an Autodesk® Burn® background processing network, or to use your Mac as a background
processing node, define Backburner settings in the Backburner tab of the Smoke Setup utility.

To configure background processing for Smoke, use the four fields in the Application Settings Section.

To use your Mac as a background processing node, define the hostname of the Backburner Manager that
will distribute processing jobs to your Mac, in the Local Server Settings section.
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(Hale) Smoke Setup

Select the application to configure ' smoke_2011.5P4.betal | & ]

! General Preview Vtr | Emulator  Media Storage Backburner | Licensing '
Application Settings
Manager Hostname localhost
Job Priority Default (7]

Server Group

Group Capability | Default o

Local Server Setting

Manager Hostname localhost

( Reload ) ( Apply )

To configure settings for jobs submitted by Smoke to a Backburner network:

1

In the Manager Hostname field of the Application Settings section, enter the hostname or IP address
of the Backburner Manager system that will handle background jobs submitted by Smoke.

Setting the Manager Hostname enables the Background Wire® and Background Proxies buttons in the
application; they are otherwise greyed out.

In the Job Priority field, enter the priority for jobs sent by Smoke to the Backburner Manager on your
rendering network. Job priority can range from 0 to 100, where O is the highest priority and 100 is the
lowest. The default is 50.

In the Server Group field, enter the name of the group of render nodes to which jobs created in Smoke
will be submitted. Refer to the latest Autodesk Backburner User Guide for information on creating groups
in Backburner Monitor.

From the Group Capability drop-down list, select whether the nodes in your group are equipped with
GPU-accelerated graphics cards or not.

Set this value as follows:

B If none of the nodes in your rendering network are equipped with GPUs, select software. Smoke will

not send jobs that require a GPU to the rendering network, but only jobs that can be rendered in
software mode by the render nodes.

B If ALL the nodes in your rendering network are equipped with GPUs, select gpu. Smoke will send all
jobs to the GPU-equipped nodes, even if some jobs do not specifically require a GPU render node.

NOTE If your rendering network also contains render nodes without a GPU, but this value is incorrectly
set to gpu, all jobs are sent only to GPU-equipped render nodes, and the nodes without a GPU are never
used.

B If your rendering network contains a mix of nodes with GPUs and without GPUs, select hybrid. The
application sends all jobs to the rendering network, and Backburner Manager distributes each job
to the appropriate type of render node.
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NOTE Select gpu or hybrid only if you are sure that at least one node in your rendering network is
equipped with a GPU. Attempting to submit a job that requires a GPU to a rendering network with no
GPU-equipped render node results in the job being stuck in the rendering queue indefinitely.

Configuring the License Server

You can use the Licensing tab to configure the location of your license server.

B To set the current workstation as your license server, click Add Localhost and click Apply.
The license server must be installed on the local workstation. See Installing Smoke with a Local Network
License Server on page 13.

m To identify another workstation as the license server, enter the name in the hostname field, click + and

click Apply.
The license server must be installed on the remote workstation. See Network License Manager on page
56.
ano Smoke Setup
Select the application to configure | smoke_2011.5P4 I3 ]
| General Preview  Vitr | Emulator = Media Storage Backburner | Licensing ]
|
License server Hostname |
127.0.0.1

( Reload ) ( |
( eloa | [ Apply )

B
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Troubleshooting Smoke
Installation, Licensing and
Configuration

Topics in this chapter:

Invalid Serial Number Error on page 35

Troubleshooting License Errors on page 36

Enabling Remote Login on page 38

Viewing Application Error Messages on page 39

Checking that Background Services are Running on page 39
Troubleshooting Hostname Changes on page 40

Forcing Smoke to Exit on page 40

Handling System Freezes on page 41

Repairing Media Storage Mount Points on page 42

Fixing VOLUMEMGT and No Volume Errors on page 42

Rebooting after an IP Address or Host Name Change on page 42
Sending Application Logs to Autodesk Customer Support on page 43
Switching Your Mac OS X Kernel between 32-bit Mode and 64-bit Mode on page 43

Invalid Serial Number Error

If you click the Activate button and enter a network license serial number, you will get an “Invalid serial
number” error.

To go from a trial to commercial or educational license of Smoke, you must re-install Smoke to install and
configure the network license server.

See About Installing Smoke with the Network License Server on page 12.
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Troubleshooting License Errors

Follow these procedures if you are unable to start Smoke due to license errors.

To troubleshoot license errors:
1 Check that Smoke is using the right license server. See Verifying the License Server on page 36.

2 If Smoke does not start and you are still getting license errors, restart the license server using the License
Server Configurator. See Restarting the License Server on page 37.

3 If Smoke does not start and you are still getting license errors, check the license and then restart the
license server. See Verifying the License File on page 37.

Verifying the License Server

If you are getting license errors when starting Smoke, you should first check that Smoke is pointing to the
right license server.

In most cases, the license server is installed on the same workstation as Smoke.
To verify the license server:

1 Start Smoke Setup. Smoke Setup can be found in the Applications/ Smoke 2011/Utilities folder.

2 Open the Licensing tab.

ano Smoke Setup

Select the application to configure | smoke_2011.5P4 | ]

| General Preview = Vtr = Emulator = Media Storage Backburner | Licensing ] ‘

License server Hostname ‘
127.0.0.1 127.0.0.1

|
(+ )X - Add Locz t

( Reload ) ( Apply )
( Reload ) ( Apply

3 Click the - button to remove a license server from the list.

4 Do one of the following:
B Click Add localhost to use the current workstation as the license server.

B Click + and then type the hostname of the license server in the Hostname field.
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5 Click Apply to confirm any changes.
You must restart Smoke to confirm if it starts with the new license server.

If Smoke does not start, try re-starting the license server. See Restarting the License Server on page 37.

Restarting the License Server

The License Server can be installed on the same workstation as Smoke. Or, it may be installed on another
workstation to manage multiple Autodesk licenses across a facility.

To restart the license server:

1 Open the Service Monitor. You can find the Service Monitor in this location: /Applications/Autodesk/Smoke
Common Utilities/Service Monitor/

Service Monitor

' Components = Troubleshooting

Component Version  Status

Backburner Manager  2011.0 . (_Start ) ( Stop ) (_ Restart )

Backburner Server 2011.0 . (start ) ( Stop | (" Restart \

Wiretap Gateway 2011052 @ (Start ) ((Stop ) (_Restart )

Wiretap Server 2011.5P3 . (“start ) ( Stop ) ( Restart )

Multi-Purpose daemon 1.1 . (" Start ) ( Stop ) ( Restart )

Stone+Wire 2011 @ (St ) (Stop ) (CRestart )

License Server (ADLM) 1.3.34 . (“start ) ( Stop ) ( Restart ) Restarted successfully

2 Do one of the following:

B If the server is not running, click Start.

B If the server is running, click Stop and then Start or just Restart.

If you get error messages when you start Smoke after restarting the license server, validate the license file
and restart the license server again. See Verifying the License File on page 37.

Verifying the License File

If you are having problems with the license server, verify that the license server is using the Smoke license.

To verify the license file:

1 Open the License Server Configurator. You can find the License Server Configurator in one of the
following places:

B If Smoke is installed on the same workstation: Applications/ Smoke 2011/Utilities

B If Smoke is not installed on the workstation: /Applications/Autodesk/Adlm
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Ao License Server Configurator

[ ServerStatus | Licenses |

Status: Stopped ( start ) Restart

2 Click the Licenses tab.

.00 License Server Configurator

| Server Status Licenses ]

Reset Apply [ Open

b

3 Cut and paste the license into the Licenses window or open the license file that you saved locally.

4 Click Apply and then restart the license server.

Enabling Remote Login

To ensure you will be able to reboot your workstation if it freezes, it is recommended that you enable remote
login on your Mac.

To enable remote login:
1 Open System Preferences, and click Sharing.
2 Enable Remote Login. Allow access to all users by selecting “All users”.

3 Close System Preferences.

38 | Chapter 5 Troubleshooting Smoke Installation, Licensing and Configuration



Viewing Application Error Messages

If you experience problems with Smoke or any of its related components, checking the error messages in
the Mac OS X system console might help you to identify the issue.

To view Smoke error messages:
1 Open the Console application from the Applications / Utilities folder.
2 From the File menu, click New Database Search.

. Nale) Database Search

Search name: Smoke errors

Find messages where all of these conditions are true: =) &)
Sender » ) |_contains * | rom.autodesk (= ()
Message = contains ) error (=1 (4}

or, find message where all of these conditions are true: (=) (4)

| Sender ¥ | contains | com.autodesk (= (+)
Message + | | contains +) | fail =) ()

Hold the option key and click the + button to add an "or” clause.

(Gancel

3 Give your search a meaningful name. You will be able to reuse it later.

4 Define the search criteria as illustrated in the previous screenshot, and click OK.

A new Console window opens and displays all messages sent by Autodesk applications or services, and
containing the words “error”, “failed” or “failure”. The search settings are saved in the left panel of the
Console window, under Database Searches.

5 Look through the error messages to find any information that might help you identify the problem. If
you encounter error messages about Backburner or Stone and Wire, refer to the following section for
information on restarting these services.

Checking that Background Services are Running

To check that all necessary background services are running, open the Service Monitor application from the
Applications / Autodesk / Smoke Common Utilities folder.
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Service Monitor

' Components Troubleshooting

Component Version Status

Backburner Manager  2011.0 . (_Start ) ( Stop ) ( Restart )

Backburner Server 2011.0 . ( Start ) ( Stop Y ( Restart

Wiretap Gateway 2011052 @ (Start ) (Stop ) (Restart )

Wiretap Server 20115p3 @ (Start ) ((Stop ) ((Restart )

Multi-Purpose daemon 1.1 . (Start ) ( Stop ) ( Restart |

Stone-+Wire 2011 @ (Start ) (Stop ) (_Restart )

License Server (ADLM) 1.3.34 . [ Start Y Stop ) ( Restart ) Restarted successfully

e

A green status light means that a service is running. A red light means that the service is not running. Click
Restart to activate it.

WARNING Before stopping or restarting a background service, make sure Smoke is not running, and that there
are no network connections to your media storage.

Troubleshooting Hostname Changes

The hostname of the license server is listed in the license file.

If the hostname of your license server changes, either manually or through DHCP (Dynamic Hostname
Configuration Protocol), it is possible that the license will become unavailable and applications will not be
able to run.

To resolve license issues caused by a hostname change:

W Edit the files /usr/local/flexnetserver/ads_server.lic and the file /var/flexlm/autodesk.lic so that the second
item on the SERVER line matches the current workstation hostname.

NOTE Do not change the Mac ID serial number (third item on the SERVER line). This will disable the license.

B Restart the license server in the Smoke Service Monitor. You can find it in Applications/ Smoke 2011/Utilities
folder.

B To prevent further issues with hostname changes, you can edit the above files and replace the hostname
with “127.0.0.1”. This will make the license insensitive to hostname changes.

NOTE Do not use “localhost” for a hostname.

Forcing Smoke to Exit

If Smoke crashes but does not close, use the following procedures to force it to quit.

1 Run the Service Monitor application from the Applications / Autodesk / Smoke Common Utilities folder.
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2

3
4

Click the Troubleshooting tab.

AanNn Service Monitor

| Components Troubleshooting l

Send Log to Autodesk Support ( Send

Force quit Smoke NOW!

Change MacOS Kernel 3zbit ) [ 64bit

Click NOW! to force Smoke to quit.

If Smoke still does not quit, use the following procedure to exit Smoke from the Terminal.

To exit Smoke from the Terminal:

1

2
3
4

Open the Terminal from the Applications / Utilities folder.
Type: sudo killall -9 smoke
Press Enter.

Enter your password and press Enter.

Handling System Freezes

If your workstation “freezes” for any reason, DO NOT force it to power off using the Power button, as this
may cause problems with your media storage.

To avoid any problems, always use the following procedure to safely restart your workstation when it freezes.

To reboot your Mac OS X workstation:

1

On a Linux® system or another Mac on your network, open a terminal and type the following command
to connect remotely to the Smoke Mac OS X workstation:

ssh <user name>@<Mac_ IP Address>
Where <user name> is a user that exists on the Smoke Mac OS X workstation, or a NIS (network)

user, and <Mac_IP Address> is the IP address of the Smoke Mac OS X workstation. You can also
use the workstation hostname instead of the IP address.

NOTE You can also connect from a Windows® system, by installing a SSH client such as OpenSSH.

Enter your password when prompted.

When you are logged into the Mac OS X workstation, type the following command to reboot it:
sudo reboot

Enter your password when prompted.
The workstation reboots.
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Repairing Media Storage Mount Points

If you force your workstation to power off, the operating system may mount the storage on an incorrect
mount point folder when it restarts (for example, /Volumes/Storagel instead of /Volumes/Storage). This issue
prevents Smoke from being able to access the media storage.

To avoid this problem, NEVER use the Power button to force a shutdown if your workstation freezes. Use
the procedure described in the previous section to safely reboot your workstation.

If you did force the workstation to power off, and are now experiencing storage issues, perform the following
procedure to delete the incorrect mount point, and to mount your storage to the proper mount point.

To delete an incorrect mount point:

—

Log into your workstation as a user with administrative privileges.
Open System Preferences, click Sharing, and disable all the file services.
Open Finder.

Press COMMAND+Shift+G, and type /Volumes in the text field.

wn A W N

In the /Volumes folder, locate the incorrect mount point folder. It should have the name of the original
mount point (for example, Storage), but its icon depicts a folder instead of a disk drive.

6 Right-click the incorrect mount point folder, and select “Move to Trash” from the context menu. Enter
your password if prompted.

The folder is deleted.

7 Restart your workstation.
The media storage should mount to the proper location (for example, /Volumes/Storage) after the reboot.

NOTE If the media storage is still not available after restart, open Disk Utility from the Applications / Utilities folder,
select your media storage disk, and click Repair Disk in the First Aid tab. See the Mac OS X documentation for
details.

Fixing VOLUMEMGT and No Volume Errors

Follow the steps below if you ever start Smoke and cannot select your framestore volume, or if you get the
following error:

Error: VOLUMEMGT : Failed to initialize Stone+Wire connection.

To solve the errors listed above:

—

Exit Smoke.

2 Open the Service Monitor application from the Applications / Autodesk / Smoke Common Utilities folder.
3 Restart the Stone+Wire service.
4

Start Smoke.

Rebooting after an IP Address or Host Name Change

If your workstation uses DHCP to obtain its network configuration, it is advisable to restart it after a change
of IP address, for instance, when switching from a wired to a wireless connection.
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Furthermore, ensure that your workstation’s hostname remains constant and is resolvable at all times in the
DHCP environment, as the media storage and networking components of Smoke (known as “Stone and
Wire”) do not support dynamic hostname changes.

Sending Application Logs to Autodesk Customer Support

If you have called Autodesk Customer Support to troubleshoot an issue with your application, you may be
asked to submit the application log files.

To submit Smoke log files to Autodesk:
1 Make sure your Mac is connected to the Internet.
2 Run the Service Monitor application from the Applications / Autodesk / Smoke Common Utilities folder.

3 Click the Troubleshooting tab.

AN6 Service Monitor

! Components Troubleshooting |

Send Log to Autodesk Support ( Send
Force quit Smoke ( NOW!
Change MacOS Kernel L 32 bit AlE 64 bit

4 Click Send.
Smoke and system log files are automatically sent to Autodesk.

Switching Your Mac OS X Kernel between 32-bit Mode and
64-bit Mode

Smoke 2011 for Mac OS X is a 64-bit application that can run on either the 32-bit Mac OS X kernel or the
64-bit kernel, while Smoke 2010 for Mac OS X specifically required the 64-bit kernel.

If you are running Smoke 2011 for Mac OS X on a workstation where Smoke 2010 for Mac OS X was previously
installed, you may need to switch the Mac OS X kernel into 32-bit mode for certain third-party drivers and
software to work properly.

Skip this section if you are running Smoke 2011 for Mac OS X on a workstation where Smoke 2010 for Mac
OS X was never installed. By default, Mac OS X comes with the 32-bit kernel activated, which can run most
64-bit applications, including Smoke 2011.

To switch the kernel between 32-bit mode and 64-bit mode:
1 Run the Service Monitor application from the Applications / Autodesk / Smoke Common Utilities folder.

2 Click the Troubleshooting tab.
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aYals) Service Monitor

| Components | Troubleshooting ]

Send Log to Autodesk Support Send
Force quit Smoke ( NOW!
Change MacOS Kernel ( 32 bit ) 64 bit

3 Click the 32 bit or 64-bit button.

4 Reboot your Mac for the change to take effect.
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Appendix: Autodesk
Licensing

Includes these chapters:
B Network Licensing on page 47

B Stand-Alone Licensing on page 65

B Licensing Glossary on page 71
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Network Licensing

Topics in this chapter:

Introduction on page 47

Plan Your Network Licensing on page 47
Network License Manager on page 56
Network Licensing Tools on page 59
License Borrowing on page 60

Introduction

A network license allows you to run an Autodesk product on a network. Network licenses can be purchased
through your Authorized Autodesk Reseller.

Setting up network licenses for an Autodesk product requires careful planning and execution. This section
gives you instructions about how to set up a network licensed environment, and assumes that you are
familiar with the terminology and processes required to set up an Autodesk product to run on a network.

Plan Your Network Licensing

This section contains information that you need to know before you set up a network license server. The
section includes information about supported license server models, license operation and availability,
network license file definitions and parameters, license file examples, license types and behaviors, and the
license server heartbeat signal.

System Requirements for the Network License Manager (Windows)

Make sure that your network license server meets the minimum recommended requirements. See the following
tables for hardware and software requirements.
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NOTE The Network License Manager supports Ethernet network configurations only.

Hardware and software requirements for the network license server (Windows)

Hardware/Software Requirement

Operating System Windows® 7® 32-bit
Windows 7 64-bit
Windows 7 Starter (32-bit)

Windows 7 Home Basic (32-bit)
Windows 7 Home Premium
Windows 7 Professional

Windows 7 Ultimate

Windows 7 Enterprise

Windows Vista 32-bit SP2 or later
Windows Vista 64-bit SP2 or later
B Windows Vista Enterprise

Windows Vista Business
Windows Vista Ultimate

Windows Vista Home Premium and Basic (32-bit)

Windows Vista Home Premium (64-bit)

Windows XP 32-bit SP2 or later
Windows XP 64-bit SP2 or later
B Windows XP Home

B  Windows XP Professional

Windows Server 32-bit SP1 or later
Windows Server 64-bit SP1 or later
B  Windows 2008 Server R2

B  Windows 2008 Server
B  Windows 2003 Server R2
B Windows 2003 Server

Computer/processor Intel® Pentium® IIl or higher
450 Mhz (minimum)

Network interface card Compatible with existing Ethernet network infrastructure

NOTE The Network License Manager supports multiple network interface cards, but at
least one must be an Ethernet card.

Communication protocol TCP/IP

NOTE The Network License Manager uses TCP packet types.

Browsers Internet Explorer® 6
Internet Explorer 7
Internet Explorer 8
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Hardware and software requirements for the network license server (Windows)

Hardware/Software Requirement

FLEXnet 11.7.0.0

Virtual Machine Support (Windows)

Hardware Virtualizer Virtual OS

Intel PC 64 Windows 2008 or Windows 2003R2 Vista 64-bit, Vista 32-bit, Windows XP 32-bit,
servers running on VMware® ESX3.5 Up-  Windows 7 32-bit (Home Premium, Profes-
date 3 (License Manager Only) sional, Ultimate, and Enterprise), Windows 7

64-bit, Windows Server 32-bit, Windows
Server 64-bit

System Requirements for the Network License Manager (Mac OS X)

Make sure that your network license server meets the minimum recommended requirements. See the following
tables for hardware and software requirements.

NOTE The Network License Manager supports Ethernet network configurations only.

Hardware and software requirements for the network license server (Mac OS X)

Hardware/Software Requirement

Operating system Mac OS® X version 10.6 and later

Computer/processor Intel Mac

Network interface card Compatible with existing Ethernet network infrastructure

NOTE The Network License Manager supports multiple network interface cards, but at
least one must be an Ethernet card.

Communication protocol TCP/IP

NOTE The Network License Manager uses TCP packet types

Browsers Safari 4.0

FLEXnet 11.7.0.0

System Requirements for the Network License Manager (Linux)

Make sure that your network license server meets the minimum recommended requirements. See the following
tables for hardware and software requirements.

NOTE The Network License Manager supports Ethernet network configurations only.

Hardware and software requirements for the network license server (Linux)

Hardware/Software Requirement

Operating system Linux® 64-bit
Red Hat® Enterprise Linux 5.0 WS (U4)
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Hardware and software requirements for the network license server (Linux)

Hardware/Software Requirement

Computer/processor Intel Pentium 3 or higher
450 Mhz (minimum)

Network interface card Compatible with existing Ethernet network infrastructure

NOTE The Network License Manager supports multiple network interface cards, but at
least one must be an Ethernet card.

Communication protocol TCP/IP

NOTE The Network License Manager uses TCP packet types

FLEXnet 11.7.0.0

Plan Your License Server Configuration

You must decide which license server model to use for managing your Autodesk product licenses on a server.
Autodesk supports the following network license server models:

B Single license server model
B Distributed license server model

B Redundant license server model

Single License Server Model

In the single license server model, the Network License Manager is installed on a single server, so license
management and activity is restricted to this server. A single license file represents the total number of
licenses available on the server.

Advantages of the Single License Server Model

B Because all license management takes place on a single server, you have just one point of administration
and one point of failure.

B Of the three license server models, this configuration requires the least amount of maintenance.

Disadvantage of the Single License Server Model

m If the single license server fails, the Autodesk product cannot run until the server is back online.

Distributed License Server Model

In the distributed license server model, licenses are distributed across more than one server. A unique license
file is required for each server. To create a distributed license server, you must run the Network License
Manager on each server that is part of the distributed server pool.

Advantages of the Distributed License Server Model

B Servers can be distributed across a wide area network (WAN); they do not need to exist on the same
subnet.
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B If one server in the distributed server pool fails, the licenses on the remaining servers are still available.
B If you need to replace a server in the distributed server pool, you do not need to rebuild the entire pool.

B Server replacement is easier than in a redundant server pool, where you must reactivate the entire pool.

Disadvantage of the Distributed License Server Model

B If a server in the distributed server pool fails, the licenses on that server are unavailable.

Redundant License Server Model

In the redundant license server model, you use three servers to authenticate a single license file. One server
acts as the master, while the other two provide backup if the master server fails. With this configuration,
licenses continue to be monitored and issued as long as at least two servers are still functional. The license
file on all three servers is the same. You must install the Network License Manager on each server.

In the redundant license server model, all servers must reside on the same subnet and have consistent
network communications. (Slow, erratic, or dial-up connections are not supported.)

Advantage of the Redundant License Server Model

B If one of the three servers fails, all licenses that are managed in the server pool are still available.

Disadvantages of the Redundant License Server Model
B If more than one server fails, no licenses are available.

B All three servers must reside on the same subnet and have reliable network communications. The
redundant server pool does not provide network fault tolerance.

B If one of the three servers is replaced, the complete redundant server pool must be rebuilt.

B If your Autodesk product supports license borrowing and licenses are borrowed from a redundant license
server pool, you must restart the license server after you stop the Network License Manager.

Learn About Your License

In this section, you learn about license operation and availability, the license file, license types and behaviors,
and the heartbeat signal.

License Operation and Availability

When you start an Autodesk product, the product determines the server from which it should try to obtain
a license. The product then requests a license through the TCP/IP network protocol to the license server.

If the number of available licenses has not been exceeded on the license server, the Network License Manager
assigns a license to the workstation. A product session then starts on the workstation, and the number of
available licenses on the license server is reduced by one.

Likewise, when you exit a product, the Network License Manager frees a license for another user. If you run
multiple sessions of an Autodesk product on an individual workstation, only one license is used. When the
last session is closed, the license is freed.
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The following three processes manage the distribution and availability of licenses:

B License manager daemon (Imgrd.exe). Handles the original contact with the application, and then passes
the connection to the vendor daemon. The Imgrd.exe daemon is used to communicate with the vendor
daemon only; Imgrd.exe does not authenticate or dispense licenses, but rather passes user requests to the
vendor daemon. By using this approach, a single Imgrd.exe daemon can be used by multiple software
vendors to provide license authentication. The Imgrd.exe daemon starts and restarts the vendor daemons
as needed.

B Autodesk vendor daemon (adskflex.exe). Tracks the licenses that are checked out and the workstations
that are using them. Each software vendor has a unique vendor daemon to manage vendor-specific
licensing. As its name implies, the adskflex.exe vendor daemon is specific to Autodesk products.

NOTE If the adskflex.exe vendor daemon terminates for any reason, all users lose their licenses until Imgrd.exe
restarts the vendor daemon or the problem causing the termination is resolved.

B License file. A text file that has vendor-specific license information.

License Files

The network license file you receive from Autodesk contains licensing information required for a network
installation. You obtain license file data when you register your Autodesk product.

The license file contains information about network server nodes and vendor daemons. It also contains an
encrypted digital signature that is created when Autodesk generates the file.

The license file is located in a network location that you specify in the Deployment wizard. That network
location must be accessible to every user who runs the product from a network installation.

The following table defines each license file parameter.

Definitions of license file parameters

Line Parameter Definition Example
SERVER Host Name Host name of the server where the Network ~ LABSERVER
License Manager resides
Host ID Ethernet address of the server where the 03D054C0149B
Network License Manager resides
USE_SERVER [None]
VENDOR Vendor Daemon Name of the server-side Autodesk vendor adskflex.exe

daemon

Port Number Network port number reserved and assigned ~ port=2080
for use only by Autodesk products running

the Autodesk vendor daemon

PACKAGE Name Name of feature code group SERIES_1
Version Internal version number reference 1.000
COMPONENTS List of feature codes supported in the pack- COMPONENTS=

age "526000REVIT_9_OF\
51200ACD_2007_OF\
513001INVBUN_11_OF"
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Definitions of license file parameters

Line Parameter Definition Example
OPTIONS OPTIONS=SUITE
SUPERSEDE Replacement for any existing Increment line  SUPERSEDE
of the same feature code from any license
files on the same license server that have a
date earlier than the defined Issue Date
SIGN Encrypted signature used to authenticate SIGN=0 SIGN2=0
the attributes of the license file
INCREMENT Feature Code Product supported by the license file 51200ACD_2007_OF
Expiration Date Amount of time the licenses are available permanent
Number of Licenses Number of licenses supported by the license 25
file
VENDOR_STRING License usage type and license behavior of ~ COMMERCIAL

the product that is supported by the license
file

BORROW

Definition of the license borrowing period
for the licenses defined under the same in-
crement line.

In this example, the maximum period that
licenses can be borrowed is 4320 hours (180
days), unless otherwise noted (for example,
BORROW=2880 means that licenses can be
borrowed for a maximum of 2880 hours,
or 120 days).

License borrowing is disabled when this
parameter is absent in the license file.

BORROW=4320

DUP_GROUP

Definition of multiple license requests when
the same user and same host share the same
license

DUP_GROUP=UH

ISSUED

Date that the license file was generated by
Autodesk

15-jul-2006

Serial Number

Serial number of the Autodesk product

123-12345678

SIGN

Encrypted signature used to authenticate
the attributes of the license file

SIGN=6E88EFA8D44C

License File Examples

License file examples are provided in this document to help you understand how the license files work for
your particular network setup. Autodesk provides a standard license file for individual products and a license
file with additional parameters for products that are sold both individually and as part of a product set.

B Standard License File. If you purchase one or more individual products that are not offered as part of a
suite of products, you receive a standard license file.
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B Standard License File with Additional Parameters. If you purchase Autodesk products that are included
in a product set and are also sold as an individual product, you receive a standard license file with
additional parameters included in the license file. The additional parameters define the sequence for
license usage so that the individual product license is used before the license for the product set.

Autodesk license file examples include a license file not specific to a product, completed license files for
single, distributed, and redundant server models, a combined product version license file, and an example
of additional parameters added to a standard license file.

Example of a License File Not Specific to a Product

Here is an example of the contents of a license file and the parameters associated with each line:

SERVER ServerName HostID
USE_SERVER
VENDOR adskflex port=portnumber
INCREMENT feature code Adskflex Version ExpDate NumberofLicenses \
VENDOR_STRING=UsageType:Behavior BORROW=4320 SUPERSEDE \ DUP_GROUP=DupGrp ISSUED=IssueDate
SN=SerialNumber SIGN= \

Example of a License File for a Single or Distributed Server

Here is an example of a completed license file for a single or distributed license server model:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD 2009 OF adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \
E368 816E D417 C1CD 7DBD 7B90 1354 D6FO0 48FE EBB8 9C84 C3AF \
7D79 BEE1l 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E0O0B D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DDOA 1292 D56F 4108 \
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"

Example of a License File for a Redundant Server

Here is an example of a completed license file for a redundant license server model:

SERVER CCN12378042 001cc4874b03 27005

SERVER XXHP0528 0019bbd68993 27005

SERVER CCN12378043 001cc4874b10 27005

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD 2009 OF adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678 SIGN="11C4 \
CA79 07FC 7ADO 409A 6E04 6E98 D76C 197C 0416 076C B211 1CDD \
DOAB 698B 16BF 7AOE D4F8 1CFE 2985 644F 64CD CECE 0DDB 5951 \
3262 7C31 13A8 FO8F 55B2" SIGN2="19A6 FDA3 2ED5 5301 8675 7B81 \
1BOE 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2 2373 \
82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DCO E066 209B 0953"
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NOTE The redundant server model requires the addition of a port number (the default is 27005) for each server.

Example of a License File for Combined Autodesk Product Versions

You can combine a license file for different releases of the same Autodesk product or for different Autodesk
products, and run all products from one license server. For example, you can combine a license file for
AutoCAD 2009 with license files for Autodesk Maya® 2009 and AutoCAD Map.

Here is an example of the contents of a combined license file for AutoCAD 2008 and AutoCAD 2009:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD 2009 OF adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \
E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \
7D79 BEE1l 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \
057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967 \
D821 BD37 BE6D B78A F074 B223 88AA 242C DDOA 1292 D56F 4108 \
62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"

INCREMENT 54600ACD 2008 OF adskflex 1.000 permanent 3 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E \
4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 COC7 90AC \
7289 152E OEA2 CCOD 3F10 577A 0489 CEB6 10D5 FBCC B552 0COD \
5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB08 7E05 \
8497 111E 092F OE54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15 8F00 \
C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A 599A"

Example of Additional Parameters in a License File

For Autodesk products that are included in a product set and are also sold as an individual product, licenses
are allocated based on a sequence of priorities defined in the license file. For those products, information
similar to the following example appears in a license file:

SERVER Serverl 1a34567c90d2

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 54600ACD 2008 OF adskflex 1.000 permanent 5 \
VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \
DUP_GROUP=UH ISSUED=09-Jan-2007 SN=123-12345678 SIGN="0247 \
45D6 87C4 27A5 T7F9E F24A ED3D 61E4 6B3B CC5C AD77 B865 9EA8 \
3D62 0792 0F67 19E7 57E7 FAFA A48B D582 335A EC1l6 1FE5 B70D \
76AB 6488 61CC DESE F5B7" SIGN2="09FD 0850 7CFl1 F447 9F05 9FA3 \
2A0A 38D6 83FC 1746 F3F5 5A72 6250 E002 DEOB OE6E F88C AC95 \
136F 87F2 A945 E4C4 A97F 44B5 74EE 83F3 3F3E 1579 B981 8994"

License Types and Behaviors

Autodesk supports dynamic product usage and license behaviors. This means that you can purchase a specific
type of behavior with a specific license and change that license at a later date without having to uninstall
and reinstall the Autodesk product.
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NOTE All license types are available as stand-alone and network except for the Student Portfolio license, which
is available as stand-alone only.

License types include the following:
B Commercial. A license for a product that was purchased commercially.

B Not for Resale. A license for a product that is not sold commercially. Not for Resale products are for
evaluation or demonstration purposes only and may not be used for commercial or production use.

B Educational (EDU)/Institution. A license designed specifically for educational institutions.

B Student Portfolio. A license for students who are using an Autodesk product as part of their curriculum.

License behaviors are as follows:
B Permanent. Enables permanent use of an Autodesk product.

B Term Extendable. Enables access to an Autodesk product for a limited time. The term can be extended
at any time.

B Term Non-Extendable. Enables an Autodesk product for a limited time. The term cannot be extended.

Heartbeat Signal

When an Autodesk product is running, it communicates with the license server at regular intervals using a
communication method known as the “heartbeat” signal. If the heartbeat signal is lost, the server tries to
reconnect. If the server cannot reconnect, the user receives a license error.

If the product stops working because it has lost a connection to the server, you must shut down the product,
and then restart it. If the problem causing the original loss of the heartbeat signal is resolved and there are
available licenses on the server, the program can be restarted.

Network License Manager

Install the Network License Manager

You can install the Network License Manager before or after you use the Installation wizard. The order in
which you install the network applications does not matter, as long as you install everything you need and
you provide consistent license server information across the network applications.

If an earlier version of the Network License Manager is already installed on the computer, you should upgrade
by installing the Autodesk Network License Manager into the folder where the older version was located.

Install the Network License Manager (Mac OS X)

To install the network license manager on Mac OS X:
1 Locate the Smoke installation media.
2 Open the Standalone Installers folder.
3 Start the Install License Server installation.
4

Follow the on-screen instructions to complete the installation.
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Install the Network License Manager (Linux)

To install the network license manager (Linux):

HOW N =

(%,

Locate the Standalone Installer folder on the Smoke installation media.
Copy the Burn folder to a Linux machine.

Log in as root.

Unzip the tar file. Type:

tar -xzvf Burn *tar.gz

Open the Burn folder created when you unzipped the package.

Install Burn. Type:
./INSTALL LICSERV

Follow the instructions in to complete the installation.

Obtain a License Through autodesk.com

You can register and activate your network license by going to https://registeronce.autodesk.com and following
the on-screen instructions.

Obtain the Server Host Name and Host ID Manually

Autodesk uses the server host name, host ID, and product serial number to generate a license file.

To obtain the information manually, you can use the command prompt or you can run the Imtools.exe
utility. If you use Imtools.exe, do not run it on a remote workstation.

To obtain the host name and ID using the Windows command prompt

1

Do the following:

B (Windows XP/Windows Vista) Click Start » All Programs » Autodesk » [Autodesk Product] »
License Transfer Utility.

At the Windows command prompt, enter the following command, and then press ENTER:
ipconfig /all
Locate the Host Name line, and write down the host name.

Locate the Physical Address line. Write down the physical address without the dashes. This is your
twelve-character host ID.

NOTE If your server has more than one network adapter, select the one that corresponds to a physical
network adapter. To determine which adapters are physical: in the Windows command prompt, enter ipconfig
/all, and then view the Description field above each physical address. If there is more than one physical
network adapter, it does not matter which one you use. Devices such as VPN adapters, PPP adapters, and
modems are not valid.

Close the Windows command prompt.

To obtain the host name and ID using Imtools.exe

You should be logged in with Administrator rights when working with the LMTOOLS utility.
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Click Start » All Programs » Autodesk » Network License Manager » LMTOOLS Utility.
In the LMTOOLS program, click the Systems Settings tab.

On the Systems Settings tab, locate the Computer/Hostname box. Copy the host name and paste the
information into a text editor.

Locate the Ethernet Address box. The Ethernet address is the host ID. It consists of twelve characters.
Write down the information. If your Ethernet address is more than twelve characters, write down the
first twelve characters only.

NOTE If your server has more than one Ethernet adapter, select one that corresponds to a physical network
adapter.

Close Imtools.exe.

To obtain the host name and ID using the Mac OS X or Linux terminal window

1
2
3

Launch a Terminal window.
Go to the directory where Imutil is installed.

Retrieve the host name by entering the following in Terminal:
<prompt>./lmutil lmhostid -hostname

The host name is displayed.

Retrieve the host ID by entering the following in Terminal:
<prompt>./lmutil lmhostid

The twelve-character host ID is displayed.

Close the Terminal Window.

Uninstall the Network License Manager

You can uninstall the Network License Manager from the license server. When you uninstall the Network
License Manager, licenses are no longer available to your users.

To uninstall the Network License Manager

1

2
3
4
5

Click Start » All Programs » Autodesk » Network License Manager » LMTOOLS Utility.
In the LMTOOLS program, click the Start/Stop/Reread tab.

On the Start/Stop/Reread tab, click Stop Server.

Close Imtools.exe.

In the Windows Control Panel, do one of the following:
B (Windows XP) Double-click Add/Remove Programs.

B (Windows 7/Windows Vista) Double-click Programs and Features.

Do one of the following:
B (Windows XP) In the Add/Remove Programs window, click Autodesk Network License Manager.
Click Remove.

B (Windows 7/Windows Vista) In the Programs and Features window, click Autodesk Network License
Manager. Click Remove.

58 | Appendix A Network Licensing



6 If prompted, restart your computer.

NOTE You must manually delete files that you created for use with the Network License Manager (such as log
files, license files, and the Options file). They are not automatically deleted when you uninstall the Network License
Manager.

Network Licensing Tools

Autodesk Network licensing tools include FLEXnet configuration tools, license borrowing, and SAMreport-Lite.
Each tool is described in the sections that follow.

This section also includes information for updating FLEXnet and installing and configuring the Autodesk
Network License Manager on a network.

FLEXnet Configuration Tools

The Network License Manager uses FLEXnet® license management technology from Acresso Software.
FLEXnet provides administrative tools that help to simplify management of network licenses. You can use
FLEXnet tools to monitor network license status, reset licenses lost to a system failure, troubleshoot license
servers, and update existing license files on the fly.

Utilities for License Server Management

FLEXnet provides two utilities for managing the license server. These tools are located in the C:\Program
Files\ Autodesk Network License Manager folder.

Imtools.exe Provides a Microsoft® Windows graphical user interface for managing the license server.
Imutil.exe Provides a set of command line options for managing the license server.

You can use Imtools.exe or Imutil.exe to perform the following server management tasks:

Start, stop, and restart the server.

Configure, update, and reread the license file.

Diagnose system or license problems.

View server status, including active license status.

Stop and Restart the License Server

Before you can perform any system maintenance on your license server, you must stop the license server.
When you have completed maintenance, you can restart the license server.

To restart the license server (Mac OS X)

To restart the license server:

1 Open the License Server Configurator. You can find the License Server Configurator in one of the
following places:

B If Smoke is installed on the same workstation: Applications/ Smoke 2011/Utilities

B If Smoke is not installed on the workstation: /Applications/Autodesk/Adlm
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aNo License Server Configurator

{Server Status | Licenses

Status: Stopped (" start ) Restart

2 Do one of the following:
B If the server is not running, click Start.

B If the server is running, click Restart.

To restart the license server (Linux)
Enter the following in Terminal:
/etc/init.d/license_server_ adlm stop

/etc/init.d/license_server adlm restart

License Borrowing

If you are running a network-licensed version of the program, you can borrow a license from a license server
to use the program for a specified time when your computer is not connected to the network.

NOTE If you have a stand-alone version of the program, you cannot borrow a license. To check your license type,
click Help menu » About » Product Information. In the Product Information dialog box, view your product
license type.

Overview

If you are using a network-licensed version of your Autodesk product and your network administrator
supports the license borrowing feature, you can borrow a product license from your network license server
to use the program when your computer is not connected to the network. Your license is automatically
returned to the license server at the end of the day on the return date you set when you borrowed the license.
You can also return a license early.

NOTE There is a limit to the number of licenses available for borrowing. If you try to borrow a license and are
notified that no licenses are available, all network licenses may already be borrowed by other users. If you are
unable to borrow a license, see your network administrator for help.
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Borrow a License

You can run the program when your computer is not connected to the network until your license-borrowing
period ends. If you don't remember the date that a license expires, you can check the date by placing your
cursor over the Borrowing icon in the program's status tray or by clicking Help » About and using the
Product Information dialog box.

When the license-borrowing period expires, the borrowed license is automatically returned to the license
server. Once your computer is reconnected to the network, you can run the program from the network or
borrow a license again.

Interaction with Other License-Borrowing Tools

Using the license borrowing feature in the program is the recommended way to borrow a license; however,
some third-party borrowing tools may also be available to you. These tools are not supported or compatible
with the license borrowing feature in the program. Other third-party or legacy license-borrowing tools that
may be available to you are the Autodesk License Borrowing utility (shipped with Autodesk products) and

the borrowing feature in Imtools.exe, a component of the Autodesk Network License Manager.

If another license-borrowing tool is active when you attempt to use the license borrowing feature, you should
proceed as follows to borrow a license for the program:

B If you run the Autodesk License Borrowing utility that shipped with your Autodesk product and then
turn on the borrowing flag for the Adskflex option or the All option, a license can be borrowed when
you start the program. However, you cannot return a license until you exit and then restart the program.

B [f borrowing is set in Imtools.exe for all products, you can either (a) use the other tool to borrow licenses
for the program or (b) stop the borrowing process in Imtools.exe and then use the license borrowing feature
in the program.

B If borrowing is set in Imtools.exe for non-Autodesk products only, you must stop the borrowing process
in Imtools.exe. You can then use the license borrowing feature to borrow licenses for your Autodesk
product. If you do not stop the borrowing process in Imtools.exe, the license borrowing feature will not
function.

To borrow a license using the Tools menu

1 Click Tools menu » License Borrowing » Borrow License.

2 In the Borrow a License window, on the calendar, click the date when you want to return the license.

This date must be within the valid date range set by your network administrator. The valid date range
is displayed in this window.

3 Click Borrow License.

4 In the License Borrowed message, click OK. The license is borrowed, and you can now use the program
while your computer is disconnected from the network.

NOTE You can verify that your license is borrowed by placing your cursor over the Borrowing icon in the
status tray, which is in the lower-right corner of the program.

To borrow a license using the Help menu

1 Click Help menu » About.
2 In the About product window, click Product Information.
3 In the Product Information window, click Borrow License.

4 In the Borrow a License window, on the calendar, click the date when you want to return the license.
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This date must be within the valid date range set by your network administrator. The valid date range
is displayed in this window.

5 Click Borrow License.

6 In the License Borrowed message, click OK. The license is borrowed, and you can now use the program
while your computer is disconnected from the network.

BORROWLICENSE Command

Borrows a product license so that you can run the product outside the network environment.
Tools menu: License Borrowing » Borrow License

Help menu: About » Product Information » Borrow License

Command line: borrowlicense

The Borrow a License Window on page 62 is displayed.

Borrow a License Window

Tools menu: License Borrowing » Borrow License
Help menu: About » Product Information » Borrow License
Command line: borrowlicense

Using the license borrowing feature, you can borrow a license from your network license server, and then
use the license when your computer is disconnected from the license server; for example, when you are
traveling for work.

The Borrow a License window has the following options:

Calendar Sets the date when you plan to return a borrowed license. The return date must be within the
range specified by your network administrator.

Borrow a License Borrows the license from the network license server based on the return date that you
specified.

Cancel Cancels the borrowing action; no license is borrowed.

Return a License

Your network license is automatically returned to the network license server on the day that the license
expires. You can also return a license earlier than the date you originally selected, as long as your computer
is connected to the network license server when you attempt to return the borrowed license.

Once a borrowed license is returned, you can borrow a license again as long as your computer is connected
to the network license server and a license is available on the server.

To return a borrowed license early, do one of the following:

B Click Tools menu » License Borrowing » Return License Early.

B Click Help menu » About » Product Information. In the Product Information dialog box, click Return
License, and then click Yes.

B [n the status tray, right-click the License Borrowing icon. Click Return License Early.
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NOTE To use the status tray to return a borrowed license early, the display settings for the status tray must be
turned on. To turn on the display settings, right-click an empty area on the status bar. Click Tray Settings.

Your license is returned to the network license server. After you return the borrowed license, you can borrow
a license again immediately as long as a license for that product is available on the network.

To check the license return date, do one of the following:

B [n the status tray, right-click the License Borrowing icon. View the expiration date for the borrowed
license.

B Click Help menu » About » Product Information. In the Product Information dialog box, under
License Expiration Date, view the license return date.

RETURNLICENSE Command

Returns a borrowed Autodesk product license earlier than the original return date that you specified when
you borrowed the license.

Tools menu: License Borrowing » Return License
Help menu: About » Product Information » Return License
Status tray: Right-click the License Borrowing icon. Click Return License Early.

Command line: returnlicense

RETURNLICENSE Command | 63



64



Stand-Alone Licensing

Topics in this chapter:

Introduction on page 65

Activate Your Product on page 66

Register Your Product on page 66

Manage Your Stand-Alone License on page 66
Transfer Your Stand-Alone License on page 68
Troubleshoot a Stand-Alone License Error on page 68

Introduction

NOTE Standalone licensing is only available for the student edition of Smoke. The commercial edition requires
network licensing.

Stand-alone licensing allows you to use your Autodesk product in trial mode for a given number of days
from the first time you launch the product. The number of days that a trial mode is active differs between
Autodesk products. You can activate your license at any time before the trial period expires.

When you activate your product, you receive an activation code. If you activate online, your activation code
is automatically retrieved from Autodesk and the product starts. Activations are also available through email,
fax, phone, or the Autodesk website.

NOTE If you are installing and using an Autodesk product on both operating systems of a dual-boot operating
system, you must obtain a separate activation code for each operating system.

The license file stays on your workstation when you uninstall your product. If you reinstall your Autodesk
product on the same workstation, the license information is still valid. You do not have to reactivate the
product.
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Multi-Seat Stand-Alone License

A multi-seat stand-alone license allows you to install, register, and activate an Autodesk product on several
workstations using a single serial number. Multi-seat licenses can be purchased through your Authorized
Autodesk Reseller.

NOTE Multi-seat standalone licensing is only available for the student edition of Smoke.

Activate Your Product

You can activate your Autodesk product either on startup or while you are running the product. If you
cannot activate online, offline activation is available.

Register Your Product

Depending on your product, registration is optional or required. If required, you are asked to create a user
Autodesk ID and associate this ID with an individual or company account. If registration is optional, you
can choose to postpone it, and you will be reminded periodically to register.

Manage Your Stand-Alone License

This section provides information about advanced stand-alone licensing tasks such as license types and
behaviors, viewing product information, saving your license file as a text file, updating your serial number,
and transferring a license.

Check Product Information

You can view detailed information about your Autodesk product and your product license (such as the
license usage type and the license behavior), and then save this information as a text file.

License usage types

NOTE All license types are available as stand-alone and network except for the Student Portfolio license, which
is available as stand-alone only.

Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.

Educational (EDU)/Institution A license designed specifically for educational institutions.

Student Portfolio A license for students who are using an Autodesk product as part of their curriculum.

License behaviors

Trial A license that allows individuals to try the product in trial mode for a specified number of days. The
trial period starts the first time you launch your product. When the trial period expires, the product must
be registered and activated to continue use.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time. The term can be extended at
any time.

Term Non-Extendable Allows access to an Autodesk product for a limited time. The term cannot be extended.
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View Product Information

You can view detailed information about your Autodesk product and your product license, such as the
license usage type and the license behavior.

To view product information

1 Launch your Autodesk product.

2 On the Help menu, click About.

3 In the About [Autodesk Product] window, click Product Information.

4 In the Product Information dialog box, view details about your product and the product license.
5

In the Product Information dialog box, click Close.

Save License Information as a Text File

You can save your product license information as a text file.

To save license information as a text file

1 Launch your Autodesk product.
2 On the Help menu, click About.
3 In the About [Autodesk Product] window, click Product Information.
4 In the Product Information dialog box, click Save As.
5

In the Save As dialog box, name the file, choose a location where you want to save the file, and then
click Save.

6 In the Product Information dialog box, click Close.

Update Your Serial Number

Your valid serial number is located on the outside of the product packaging or in the Autodesk Upgrade and
Licensing Information email you received if you downloaded your product.

When you register and activate your product, you are asked for the product serial number, which is
automatically entered upon completion of the activation process.

If you have a multi-product bundle of software that uses a single serial number, only the first product you
register and activate displays the updated serial number. For other products to display the serial number,
you must update it from the Help menu.

NOTE For the updated serial number to display, you must be logged into the system with Administrator rights.

To update your serial number
1 Launch your Autodesk product.

2 On the Help menu, click About.

3 In the About [Autodesk Product] window, click Product Information.
4 In the Product Information dialog box, click Update.
5

In the Update the Serial Number dialog box, enter your product serial number.
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The serial number is located on the outside of the product packaging or in the Autodesk Upgrade and
Licensing Information email you received if you downloaded your product.

NOTE If you have lost your serial number, contact the Autodesk Business Center (ABC) at 800-538-6401 for
assistance.

6 Click OK. You can now see the updated serial number.

Transfer Your Stand-Alone License
About the Licence Transfer Utility
Install the Autodesk Product

Export a License

Import a License

Troubleshoot a Stand-Alone License Error

When you activate your Autodesk product, only the computer that you used to activate the product is
licensed to run the product. If you make certain changes to your computer, your stand-alone license might
fail. You will receive a license error and you will not be able to use your product. This section discusses ways
in which you can troubleshoot a license error.

Some license errors require you to reactivate your product. If you need to reactivate your product, the Product
Activation wizard is displayed when you try to run the product. To reactivate your product, follow the
instructions in the Product Activation wizard.

The following topics offer more details regarding specific errors.

Hardware Changes

If you replace or reconfigure hardware on the computer where your Autodesk product license resides, the
stand-alone license might fail. You will not be able to use your product.

To prevent damage to your product license, use the License Transfer Utility to export your license file. After
you make the hardware change, you can import the license file back. For instructions about using the License
Transfer Utility, see Transfer Your Stand-Alone License.

NOTE If you get a license error when you change your hardware, you may have to reactivate your license. See
Activate Your Product on page 66.
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Reinstalling an Operating System

If you reinstall your operating system on the computer where your Autodesk license resides, the license
might fail. You will not be able to use your product.

To resolve a license error in this case, you must reactivate your product. See Activate Your Product on page
66.

To prevent a license error when you reinstall an operating system

NOTE If using Norton Ghost™ or another image utility, do not include the Master Boot Record.

1 Locate one of the following folders and make a backup copy:
B (Windows XP) C:\Documents And Settings\All Users\Application Data\FLEXnet

B (Windows 7/Windows Vista) C:\ProgramData\FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally copied the folder in step 1.

You can now run your Autodesk product.

Changing the System Date and Time

Your product license allows for time changes to the system clock within two days of the current time. If you
set your system clock back more than two days, the next time you start your product, you will receive a
message that gives you the option of correcting the system clock. If you do not correct the system clock,
you receive a license error.

To prevent a license error due to a change in system date and time

B Make sure that your computer's system date and time are accurate when you install and activate your
Autodesk product.

Distributing Software Image to Multiple Computers

You can use the Deployment Wizard’s Stand-alone option to create a software installation image on your
server. You can distribute this image by making it available on your computer network. During creation of
this image, you are prompted for registration information, which is stored with the image and deployed to
all installations.

Additionally, you can manually distribute the software using the installation CD that comes with your
Autodesk product. However, if your computers do not have an Internet connection, make sure the registration
data for each computer matches exactly. Inconsistent registration data can cause activation failures.

To prevent a license error when distributing software image to multiple computers

B The distribution of applications using “ghosting” is not recommended, and can result in incomplete
installations and activation problems.

Preserving Licenses on Re-Imaged Computers

On a network license server, licenses are maintained on the server. No additional steps are needed to preserve
network licenses.
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For stand-alone licenses, you need to export the licenses to a safe place before re-imaging the computers.
You can use the License Transfer Utility to export the licenses. After the re-imaging, import the licenses to
the correct computer. Each license only works on the computer for which it was created.
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Licensing Glossary

Topics in this chapter:

B Glossary on page 71

Glossary

ADSKFLEX_LICENSE_FILE In a distributed license server configuration, the environment variable used to
point a workstation to the distributed license servers.

adskflex.exe The Autodesk vendor daemon used with the FLEXnet license technology. This daemon keeps
track of the Autodesk licenses that are checked out and the workstations that are using the licenses.

borrowed license A license that allows you to use an Autodesk product for a limited period of time without
having to buy a separate license or have network access to the license server.

daemon A program that runs continuously in the background of a computer. The daemon handles requests
from the computer and then forwards the requests to other programs or processes. The Network License
Manager uses two daemons: the vendor daemon (adskflex.exe) and the license manager daemon (Imgrd.exe).

debug log file A file used with FLEXnet to log connection activity (such as license failure or starting and
stopping) between the Network License Manager and the workstation.

deployment The files and folders created on a server and used by workstations to install Autodesk programs.

distributed server A license server configuration option in which several servers are used to manage license
distribution. Each distributed license server has a unique license file and a fixed number of licenses. If one
distributed license server fails, the other servers are still able to distribute their licenses.

Ethernet address See host ID.
feature code A license file parameter that represents the product that is supported by that license file.

FLEXnet The Acresso Software license management technology implemented in the Autodesk family of
products.
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heartbeat signal The communication signal between the Network License Manager and the workstation to
verify that the workstation is accessible and has an active Autodesk product session running.

host ID The unique hardware address of a network adapter. Also known as Ethernet address or physical address.

host name The TCP/IP name associated with a computer. FLEXnet technology uses the host name as a
parameter; the host name must be distinguished from the NetBIOS (server) name.

idle A state of inactivity in your product that prompts a network license server to reclaim a license. Inactivity
is due to no mouse or keyboard activity and no commands, LISP expressions, menu macros, or scripts in
progress for the period of time that is defined in the Options file. See also license timeout.

JRE (Java Runtime Environment) A program that is required to run Java programs. This program must be
installed with SAMreport-Lite.

license file A file used with FLEXnet that controls the number of available seats. This file must be in ASCII
plain text format.

license server A server that contains the Network License Manager.

license timeout A feature that allows you to set up a timeout period on your license server to automatically
return an idle license to the server so that it is available for use again.

licpath.lic In both single and redundant server configurations, the file used to point the workstation to the
FLEXnet license server. Licpath.lic is located in the root installation folder.

Imgrd.exe The license manager daemon. This daemon handles the original contact with the program, and
then passes the connection to the vendor daemon, adskflex.exe.

Imtools.exe A graphical user interface utility used to administer the FLEXnet license technology. (Lmutil.exe
is the command line version of this utility.)

Imutil.exe A command line utility used to administer the FLEXnet license technology. (Lmtools.exe is the
graphical user interface version of this utility.)

master daemon See Imgrd.exe.

network license installation A type of installation that requires you to install and run the Network License
Manager from a network server. You must install and configure the Network License Manager before clients
can run the Autodesk product.

Network License Manager The technology used by Autodesk for network license management.

Options file The file used by FLEXnet to control license manager parameters, such as reserving licenses and
creating report logs used with SAMreport-Lite.

physical address See host ID.

redundant server A license server configuration option in which three servers are used to administer licenses.
The redundant servers share a license file and a pool of licenses. The redundant server pool remains functional
as long as two of the three servers are running and communicating with each other.

report log file A file used with FLEXnet and SAMreport-Lite. This log file provides information about network
license usage. The Options file creates the report log.

SAMreport-Lite A version of Acresso Software's SAMreport tool. SAMreport-Lite is included on the Autodesk
product discs.

vendor daemon See adskflex.exe.

workstation A desktop computer used by an individual user on a network.
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